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Overview
Welcome to the Nikkei National Museum & Cultural Centre digitization manual for object photography! 
Questions? Contact the NNMCC Collections Team at archives@nikkeiplace.org.

The creation of this manual was possible thanks to support from the Government of Canada Museum 
Assistance Program Digital Access to Heritage. Special thanks to consultants Kayla Isomura and Kota 
Matsumura and to the Museum of Anthropology at the University of British Columbia.

Some images are sourced from the Nikon Z 50 Online Manual and Godox Instruction Manuals for AD300Pro 
and XProII-N.

Revisions by: 
Sam Frederick, Digitization Technician (2024)
Lisa Uyeda, Collections Manager (2024)
Bailey Irene Midori Hoy, Collections Assistant (2023)
Madelyn Martin, Collections Assistant (2021)
Nathan Yeo, Collections Assistant (2019)

French translation by:
France Jodoin, traductrice agréée (2024)

Design by:
Danielle Jette (2024)

This manual will outline: 
1.	 How to conduct object photography to create high resolution preservation files to preserve our 

archival records and objects. 
2.	 How to create derivative access copies to make accessible our archival records and objects. 
3.	 How to complete image corrections on primary access copies using Adobe Photoshop.
4.	 How to transfer the files with checksums. 
5.	 Recommendations on how to save and backup the files.

Future improvements of the manual to include:
1.	 How to photograph books and other bounded text.
2.	 How to use a tethered software that offers live view.
3.	 How to use a macro lens.
4.	 Detailed instructions on using a light meter.
5.	 How to complete image corrections using Adobe Photoshop Elements.
6.	 Additional example chapters for photographing specific types of objects.

mailto:archives@nikkeiplace.org
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Definitions
Digitization is the process of copying analogue material in any form (textual record, graphic material – 
photographs/negatives/etc., sound recording, moving image, or objects) to a digital file form using a device 
such as a scanner, a camera, or any other electronic device. (Source: www.indigitization.ca) 

There are three types of digital files created when digitizing a record/item:
1.	 Preservation file: the highest quality copy to maintain for long-term preservation. Once produced and 

a primary access copy is created, the preservation file is stored and no longer handled.
2.	 Primary access copy: a working copy of the preservation file and is the source for all other derivatives 

(high resolution, low resolution, and custom resolutions). 
3.	 Access copy: a copy of the primary access copy, often in a lower resolution and in an accessible file 

format (e.g. JPEG, PDF, etc.) for purposes of viewing, printing, thumbnails, websites, etc.
(Source: www.indigitization.ca)

DPI and PPI are both used in describing the resolution of an image. 
1.	 DPI, or dots per inch, refers to the number of dots per inch of an image printed by a printer. 
2.	 PPI, or pixels per inch, refers to the number of pixels per inch of a digital image. 

The terms are often used interchangeably but it is important to be aware of the distinction in their use for 
digital vs printed images. 
(Source: FADGI guidelines)

Accession number is a unique identifier assigned to archival items and objects for ease of locating and 
distinguishing the item. Accession numbers are often sequential and help identify groupings of items and 
objects from the same collection. At the NNMCC, we assign an accession number to the collection level first 
based on the year processed, e.g. 2024.1. Additional numbers are included to identify groupings and/or items 
arranged within the same collection, e.g. 2024.1.1.1, 2024.1.2.1, 2024.1.2.2, etc.

There are several camera angles that can be used for object photography:
1.	 Straight on angle: the camera is positioned in front of the object in line with the object’s height. This 

angle can be used for multiple views depending on how the object is positioned and supported.
2.	 Three-quarter angle: the camera is positioned in front of the object and slightly above, pointed 

downwards. The object is placed at an angle to the camera so the front, side, and the top of the object 
are all partially visible in the camera frame. This angle is only used for ¾ views.

3.	 Overhead angle: the camera is positioned directly above the object and pointed downwards. This 
angle can be used for multiple views depending on how the object is positioned and supported.

4.	 Close-up angle: the camera is positioned close to the object to capture small details or features. The 
camera may be removed from the tripod and the focal length can be increased to magnify the object. 
A macro lens can also be used for very small objects to extend the maximum focal length of the 
camera and allow for increased magnification. 

Camera orientation is the horizontal or vertical position of the camera in relation to the object. 
1.	 Portrait or vertical orientation: the height of the camera frame or photograph is larger than the width.
2.	 Landscape or horizontal orientation: the width of the camera frame or photograph is larger than the height.

http://www.indigitization.ca
http://www.indigitization.ca
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Depth of field refers to the distance, or depth, of a photograph that is in focus. A higher depth of field will 
mean that the foreground, subject, and background are in sharp focus. A low depth of field will have a blurred 
background and some blurring in the foreground. 

Large 3D objects and those with many components will require a higher depth of field for the whole object 
to be in focus. The depth of field can be increased or decreased by adjusting aperture, focal length, or the 
distance from the camera to the object. 

Standards
We are following the recommendations set out in the following standards:

•	 Federal Agencies Digital Guidelines Initiative (FADGI) Technical Guidelines for Digitizing Cultural 
Heritage Materials, May 2023 (http://www.digitizationguidelines.gov/guidelines); 

•	 Minimum Digitization Capture Recommendations by the ALA’s Association for Library Collections and 
Technical Services, June 2013 (http://hdl.handle.net/11213/89); 

•	 BCR’s CDP Digital Imaging Best Practices Version 2.0, June 2008 (https://sustainableheritagenetwork.
org/digital-heritage/bcrs-collaborative-digitization-program-digital-imaging-best-practices-
version-20);

•	 Canadian Heritage Information Network’s National Heritage Digitization Strategy – Digital Preservation 
File Format Recommendations, March 2021 (https://www.canada.ca/en/heritage-information-
network/services/digital-preservation/recommendations-file-format.html); 

•	 Canadian Heritage Information Network’s Digitization Standards for the CMCC: Scan and Artifact 
Photography, August 2017 (https://www.canada.ca/en/heritage-information-network/services/
digitization/standards-canadian-museum-civilization.html); 

•	 The American Institute for Conservation Guide to Digital Photography and Conservation 
Documentation, 2017 (https://www.culturalheritage.org/publications/books-periodicals/shop/the-aic-
guide); and

•	 Indigitization Toolkit, 2018 (https://www.indigitization.ca/toolkit/).

http://www.digitizationguidelines.gov/guidelines
http://hdl.handle.net/11213/89
https://sustainableheritagenetwork.org/digital-heritage/bcrs-collaborative-digitization-program-digital-imaging-best-practices-version-20
https://sustainableheritagenetwork.org/digital-heritage/bcrs-collaborative-digitization-program-digital-imaging-best-practices-version-20
https://sustainableheritagenetwork.org/digital-heritage/bcrs-collaborative-digitization-program-digital-imaging-best-practices-version-20
https://www.canada.ca/en/heritage-information-network/services/digital-preservation/recommendations-file-format.html
https://www.canada.ca/en/heritage-information-network/services/digital-preservation/recommendations-file-format.html
https://www.canada.ca/en/heritage-information-network/services/digitization/standards-canadian-museum-civilization.html
https://www.canada.ca/en/heritage-information-network/services/digitization/standards-canadian-museum-civilization.html
https://www.culturalheritage.org/publications/books-periodicals/shop/the-aic-guide
https://www.culturalheritage.org/publications/books-periodicals/shop/the-aic-guide
https://www.indigitization.ca/toolkit/
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Timing estimates
The time required for your object photography project will depend on the size and number of the objects 
being photographed. Add in more time for unpacking, handling, and light cleaning of each object, as well as 
for testing different camera settings and equipment layouts to achieve the ideal shot.

1.	 Set-up of camera settings and equipment: 2 hours.
2.	 Object set-up and photography: 20 minutes to an hour per object based on experience and comfort 

level. Objects requiring multiple views and camera angles will require more time.

Materials needed
Some of these materials are optional but will contribute to higher-quality photographs. 
For the specific equipment models used in this manual, see Appendix A: Equipment list and care.

1.	 External hard drive
2.	 DSLR or mirrorless camera, including battery and USB cable
3.	 Additional lenses as needed
4.	 Tripod and overhead attachment arm
5.	 Laptop and table/desk
6.	 Backdrop and stand
7.	 Table, stands, mounts, and foam supports for objects
8.	 Clamps to secure backdrop to table
9.	 Lightbox
10.	 Lights, light stands, umbrellas, and reflectors
11.	 Wireless flash trigger
12.	 Light meter
13.	 Sandbag and weights to offset weight of camera (can use rice, beans, sand, etc. in a ziplock bag)
14.	 Grayscale or colour target 
15.	 Level
16.	 Metric scale
17.	 Gaffer tape
18.	 Cotton or disposable vinyl/nitrile gloves
19.	 Hand-held air blower and soft brush for cleaning dusty objects
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Object care and handling
Treat every object as if it were the most important item in the collection.

1.	 Wear comfortable clothing with no jewellery, watches, buckles, or anything that may get caught with 
the object.

2.	 Ensure that your pockets are empty before handling the object.
3.	 Wear clean cotton or disposable vinyl/nitrile gloves when handling the object unless the object is very 

slippery. Change gloves often if they become dirty. 
a.	 If using cotton gloves that have a rubber grip, wear the gloves on the opposite side so the grip is 

not touching the object.
4.	 Check the condition of the object before handling and review for any concerns, e.g. mold, damage that 

might get worse when handling, etc. Contact the NNMCC Collections Team if you have any questions.
5.	 Know exactly where you will be putting the object when you pick it up. Check to ensure that all 

elevators, doors, and walkways are clear and can accommodate the object. 
6.	 Be aware of your surroundings – do not make any abrupt movements and avoid walking backwards.
7.	 Protect the object from being injured (bumped, skidded, or jostled). Move objects one at a time to 

reach those at the back shelf.
8.	 Carry one object at a time and always carry the object with two hands. Ask for help when lifting heavy 

objects.
9.	 Use a supportive tray and cart, especially for distances greater than 1 meter. 
10.	 Avoid lifting suitcases, trunks, and other objects by their handles.
11.	 Use tables, stands, mounts, foam, and other materials to best support the object being photographed.
12.	 Handle each object as little as possible and do not hurry. Be patient and take breaks.
13.	 Do not eat, drink, or smoke around objects.
14.	 Never leave objects sitting on the floor.
15.	 If an object is dusty, use a hand-held air blower (please do not wipe the surface with a cloth or duster, 

or use compressed air, or blow on it). If the dust remains after using the hand-held blower, gently use a 
soft clean brush to lift dust from the surface. 

WARNING: Only use the soft brush if the object is stable, securely held in place, and will not cause 
damage to the object (e.g. no surface scratches or pulls and tears). 
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Get ready to photograph
Have a plan for your photography session, determining the room requirements, equipment, and work space 
you will need, and prepare your work space.

1.	 Assess the object(s) that will be photographed to determine the equipment needed and plan the 
placement of the object.

a.	 Questions to consider: Will a base for the object be needed? Will it fit inside the lightbox? Is the 
work surface secure and wheels locked?

2.	 Determine where object photography will take place, considering the size of the room, available 
lighting and outlets, and accessibility for transporting objects.

TIP: Avoid rooms with many wall hangings or decorative items, particularly behind where the camera 
will be, as these may interfere with photographing reflective objects.

3.	 Ensure the camera and light batteries are charged and have a spare battery charging.
4.	 Retrieve the object photography equipment and the object(s) to digitize.
5.	 Group the objects to be photographed by size and type. Similar size objects should be photographed 

together to avoid constant adjustments to the tripod and light stands.

TIP:  Leave objects that may leave dirt and residue on the backdrop until the end, e.g. leather that is 
decaying or objects with loose fibers.
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Workflow
Follow this general workflow when conducting object photography to achieve 
consistent, high-quality images of your objects. Modify and specify the workflow 
based on your own equipment, photography room, and file saving conventions 
as needed.

For suggestions on how to track the progress and setting choices of your 
photography project, see Appendix B: Project documentation.

1.	 Set-up: Prepare the photography area and set up the camera equipment 
and lighting, including a tethered laptop if desired. Create a custom or 
preset white balance setting on the camera for the photography session. 
Place the object, scale, and colour target in the photography area.

2.	 Image capture: Confirm camera settings, particularly image quality 
(RAW), ISO (lowest possible), mode (Aperture Priority or Manual), and 
white balance (custom or preset). Fill the camera frame with the object, 
confirm focus, and take photograph(s). Transfer photographs to a 
computer.

3.	 Post-photography processing: Rename files following the institution’s file 
naming conventions. Create TIFF preservation files and primary access 
copies. Perform any needed corrections for exposure and colour balance 
on access copies. Create JPEG derivative access copies.

4.	 File management: Save the files on a reliable server or computer 
following the institution’s file management system. Back up the files to an 
external hard drive or cloud-based storage if possible.
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Safety considerations
Be aware of your surroundings and plan ahead to minimize safety risks when using the equipment. Consider the 
safety of both the staff and volunteers and the objects.

1.	 Keep equipment and cords away from frequently used pathways. Clearly identify the location of 
equipment and cords on the floor to avoid tripping. Mark the edges of equipment placed on the floor 
(e.g. tripod legs or sandbags) with gaffer tape. Secure cords to the floor with gaffer tape or use a cord 
protector. Ensure cords are not stretched so tight as to rise above the floor.

2.	 Use sandbags for the light stands and the overhead attachment arm on the tripod to balance the 
heavy weight of the equipment. Secure with gaffer tape when needed.

3.	 Expand the base of the tripod and light stand before attaching the camera or lights. The stands do not 
need to be fully raised but they should have a stable base before adding equipment. Always securely 
lock each part of the stand after making adjustments.

4.	 Avoid looking directly into the lights when they are turned on.
5.	 Do not leave objects under direct light for long periods of time. Turn off the lights or move objects out 

of the photography space during long breaks between photographs.
6.	 Communicate with staff and visitors and prepare signage to indicate that the room is in use for 

photography to avoid additional foot traffic.
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Image 1: Lightbox.

Equipment set-up
Set up the photography space with a backdrop, lighting, tripod, tethered computer, and other equipment as 
needed.

For more on the specific equipment used in this manual and video instructions for set-up and take-down, see 
Appendix A: Equipment list and care.

Backdrop, stands, and supports
Set up the background for your photographs with neutral, clean backdrops and adequate supports based on 
the size and type of your objects.

Lightbox 
1.	 Smaller objects can be photographed using a lightbox, with no additional backdrop or lighting 

needed. Set up the lightbox on a table with the light strip at the top and attach the white backdrop 
(Image 1).

2.	 Plug one end of the cable into the connector on top of the lightbox and the other end into an outlet. 
Adjust the lighting by rotating the dial on the dimming controller.
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Backdrop
1.	 For larger objects, use a gray or white backdrop and a table or stand to display the object (Image 2).

TIP: A neutral gray backdrop is best for photographing 3D objects to show the contrast and depth of 
an object.

2.	 Set up the backdrop stand, starting with the side pieces. Set up a wide base on each side. 

TIP: You can adjust the height of the sides of the backdrop stand after attaching the top bar with 
backdrop. This will prevent the need for a stool when attaching the top bar.

3.	 Set up the top bar of the backdrop stand. The bar has four sections of 75 cm each, with pins that will 
click into place when attached. Adjust the size of the bar as needed based on the size of the object(s), 
leaving extra space on both sides of the object when photographing.

a.	 The two bar sections with larger openings on one end will be the end pieces of the bar.
4.	 Place the backdrop on the top bar by inserting the bar through the fabric opening at the top of the 

backdrop.
5.	 Remove the wing nut and washer from the top of the side stands and attach the top bar with backdrop, 

resecuring the nut and washer. 
a.	 Ensure the velvet/textured side of the backdrop is showing towards the front.

6.	 Adjust the height of the backdrop stand as needed. Smooth out the backdrop and gather any extra 
fabric at either end of the stand.

TIP: Use a clean backdrop for photographs. If the backdrop is dirty, machine wash with a non-scented 
detergent and no softener, tumble dry on low.

Image 2: Backdrop stand.
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Table, base, and stand for object
1.	 Place a table in front of the stand and drape the backdrop over it. Use clamps to secure the backdrop 

to the table as needed (Image 3).
a.	 Backdrop should be draped over the table without a crease or seam at the back to avoid 

shadows.

WARNING: Be mindful of the draped backdrop ends to avoid accidentally pulling the backdrop.

2.	 If a base is required for the object, place a piece of thick foam or supportive mount underneath the 
backdrop, below where the object will be placed (Image 4).

3.	 For larger objects like furniture, kimono and other garments, a table will not be necessary and the 
object can be placed directly on a base or stand in front of the backdrop. For more on photographing 
kimono, see Kimono and textiles.

Image 3: Drape backdrop over table. Clamp in place as needed.

Image 4: Place mount or foam underneath backdrop for objects that require support.
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Lighting
Find a lighting set-up that will provide balanced light to reduce shadows on the object or backdrop or over-
exposure circles from direct light. 

Changes to lighting during photography will impact post-photography processing. For suggestions on tracking 
lighting changes, see Appendix B: Project documentation.

Light stands
1.	 Set up the base of the light stands, placing a sandbag with 1.4 kg (3 lbs) of weight or more at the base 

of each stand as needed to balance the weight of the lights (Image 5). 
2.	 Ensure the metal spigot on top of the stand is inserted vertically, and tighten the screw to secure it 

(Image 5).
3.	 Attach a bracket to the base of each light by rotating the wheel at the top of the bracket (Image 6).
4.	 Mount the light on the metal spigot and tighten the screw to secure the light. The bracket should fit to 

the base of the spigot.

Image 5: Set up the light stands and place a sandbag at the 
base as needed. Metal spigot should be vertically inserted at 
the top.

Image 6: Attach bracket to each light.

TIP: Position the front of the light over one of the legs of the stand rather than the empty space 
between the legs for a secure support (Image 7).

Image 7: Attach the light to the stand, positioning the front of the light over 
one of the stand legs for balance.
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5.	 Position a light stand on either side of the camera (Image 8). 
a.	 For 2D objects, place the light stands at a 25 degree angle to the object to minimize glare and 

shadows. 
b.	 For 3D objects, the angle of the light stands can be larger to produce shadows that show the 

depth of the object. The two light stands can be placed at two different angles or distances from 
the object to achieve the desired shadows. Adjust the angle and use diffusers and reflectors so 
that only one set of shadows from the object is visible. For more on the use of reflectors and 
diffusers, see Reflectors and diffusers.

Image 8: Examples of photography set-ups for 2D and 3D objects. For 2D objects, position light stands at 25° angles from the object to 
minimize glare. For 3D objects, the angle of the light stands can be greater to show the object’s depth.

2D Object Set Up

3D Object Set Up

3D Object

LightLight

2D Object

25°25°

Camera

LightLight
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6.	 Adjust the angle of the lights and the height and distance of the light stands from the backdrop based 
on the size and type of the object(s) to be photographed.

a.	 Readjust the light stands when switching to a different object size and type. Keep the light stand 
height and distance consistent for each group and camera angle, i.e. all overhead photographs of 
the same object should have static lighting.

b.	 If using the custom white balance camera setting, a new white balance preset will need to be 
created each time the lighting is changed. For more on setting white balance, see Camera settings.
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Lights and flash trigger
1.	 Ensure the light batteries are charged and insert the batteries into each light. The batteries will lock 

into place.

WARNING: Remove the covers from the lights and any foam surrounding the bulbs before turning on 
the lights.

2.	 Press and hold the power button to turn on the studio lights. A short press will turn off the lights.

TIP: Turn off the lights when you are not using them and avoid turning them on and off frequently to 
prolong the life of the lights. Avoid leaving the object(s) under direct light for long periods.

3.	 Ensure the wireless feature on the lights is turned on. If a wireless icon is not visible in the top left 
corner of the screen, press the Wireless Selection button to turn it on (Image 9).

4.	 Turn on the flash trigger (Image 10).

Image 9: Display screen on light showing wireless icon, channel 
and group display, mode, and flash output.

Image 10: Turn on the flash trigger to sync the lights with the 
trigger. Power switch is on the right side of the trigger.

Image 11: Back of the light showing Group/Channel button, Mode button, 
Modelling Lamp button, and Test button. 

5.	 Set a group and channel for the lights and flash trigger. Select the same group/channel for each so 
they can communicate with each other.

a.	 Lights: Press the Group/Channel button to select a group from A to E. Once a group is selected, press 
and hold the Group/Channel button until the channel number at the top of the screen starts flashing. 
Rotate the SET dial to select a channel from 1 to 32 and press in on the dial to set (Image 11).

M: Manual flash

Manual flash output

Wireless Channel

Group
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b.	 Trigger: Select a group from A to E by pressing the corresponding button on the left side of the 
screen. To set a channel, select Menu > Wireless > Channel (CH). Rotate the dial and press SET to 
select a channel from 1 to 32. Press Menu to return to the home screen (Images 12 and 13).

TIP: You can set the group to A and the channel to 1 for both the lights and the flash trigger. These 
should already be preset on the equipment so confirm they are correct.

6.	 ID: “Off” on lights and trigger
a.	 Lights: Press the Menu button and scroll to F7. Press in on the SET dial and scroll to set ID to Off 

(Image 14).
b.	 Trigger: Press the Menu button and select the Wireless menu. Scroll to ID and set to Off.

Image 12: Flash trigger showing Group buttons, Mode button, 
Test button, and Function button 4 for modelling lamp.

Image 14: Turn off ID on lights.

Image 13: Select the wireless menu and set channel on the 
flash trigger.

7.	 Test the connection between the trigger and the lights by pressing the Test button on the trigger, 
indicated with a flash symbol (Image 12). 

a.	 If the lights flash, the trigger and lights are connected. If not, review the channel, group, and ID settings.

TIP: Once synced, changing settings on the trigger will automatically change the settings on the 
lights. You can change the settings directly on the lights but this will be overridden by further changes 
to the trigger settings.
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8.	 Mode: Manual or TTL (automatic)
a.	 On the trigger, select the group and press the Mode button to change between modes. Manual 

mode allows for more control over the lighting while TTL mode will adjust the flash automatically 
for correct exposure based on the camera settings (Image 12).

b.	 In Manual mode, select the group and adjust the flash output of the light by rotating the dial.
i.	 1/256 is the weakest flash output that the flash can fire while 1/1 is the maximum.

c.	 Flash output cannot be adjusted in TTL mode but exposure compensation can be adjusted from 
-3.00 to +3.00.

TIP: You can change the mode and flash output directly on the lights but this will be overridden by the 
trigger settings. Press the Mode button on the lights to change modes and rotate the SET dial to adjust 
the flash output (Image 11).

9.	 Modelling lamp: 
a.	 The modelling lamp provides continuous light as a preview of the final lighting for the 

photograph based on the flash settings.
b.	 On the trigger, turn on the modelling lamps by pressing the corresponding Function button 

at the bottom right side of the screen. The button is indicated by the lamp icon on the screen 
(Image 12).
i.	 The modelling lamp can also be turned on directly on the light by pressing the modelling lamp 

button on each light (Image 11).
c.	 Press and hold the modelling lamp button on each light to adjust the brightness and colour 

temperature of the lights. Press the SET dial to switch between brightness and colour 
temperature and rotate the dial to set the value. Press the MENU button to return to the home 
screen (Image 15).
i.	 Brightness can be set from 1 to 10 and colour temperature can be set from 3000K to 6000K, 

depending on the needs of the photography space and the camera settings. A colour 
temperature around 5000K will provide the most natural light.

ii.	 Brightness can also be set on the trigger by percentage, which roughly corresponds to the 
numbered settings on the light. With the modelling lamp on, select the group on the trigger 
and press and hold the modelling lamp Function button. Adjust the brightness by rotating the 
dial (Image 16).

Image 15: Adjust the brightness and colour temperature of the 
modelling lamps on the lights.

Image 16: Adjust the brightness of the modelling lamps 
using the trigger.
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10.	 Turn off the overhead room lights to test the studio lights with the equipment set-up. Adjust the light 
settings and position as needed.

TIP: Press the Test button on the trigger or lights each time the lighting settings are adjusted before 
taking a photograph. This allows the light to cycle back up to full power before the next flash. 

11.	 When finished testing the set-up, turn off the studio lights until you are ready to take photographs.

Light meter
1.	 Use a light meter to more accurately determine the flash output for correct exposure when using 

Manual mode on the lights (Image 17).

2.	 Confirm the settings on the camera before using the light meter. For recommended settings, see 
Camera settings.

3.	 Input the camera’s shutter speed and ISO on the light meter and hold the meter directly in front of the 
object to measure the flash.

4.	 Based on the aperture indicated on the meter, adjust the flash output to achieve the desired aperture 
for the photograph. E.g. if the aperture on the meter reads f11 but the desired aperture is f8, lower the 
flash output and remeasure with the light meter.

5.	 Take a new measurement each time the lighting power or position is adjusted.
6.	 For more on the purpose of a light meter, see Appendix A: Equipment list and care.

Image 17: Use a light meter to measure the lighting set-up. 
The aperture based on the current lighting is displayed in the 
bottom right corner. 
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Reflectors and diffusers
1.	 Change the strength or spread of the light by using reflectors or diffusers.
2.	 For fuller light coverage, use umbrellas to bounce the light (Image 18).

a.	 Open the umbrella and feed the shaft through the hole at the top of the light bracket. The light 
should face into the umbrella. Tighten the knob to secure the umbrella.

b.	 Aim the light away from the object with the back of the umbrella facing the far wall opposite the 
object.

c.	 Adjust the angle of the light and umbrella as needed.

Image 18: Use umbrellas to bounce light or a white reflector to reduce shadows 
on the object as needed.

3.	 To soften the light and reduce shadows around or inside the object, use a white reflector or coroplast/
foam core boards. 

a.	 Hold the white reflector or board to the side or in front of the object, outside of the camera 
frame. Adjust the angle of the reflector as needed (Image 18). 

b.	 The reflector or board will need to stay in place for the photograph. If one person is holding the 
reflector or board, assign a second person to press the shutter to take photographs.

TIP: When opening the reflector, grab one of the handles and hold it out to your side away from any 
equipment. The reflector will spring open. Unzip the cover to choose the desired colour.

WARNING: Avoid looking directly at the lights when holding the reflector or board.
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4.	 To further soften the light, use the translucent panel on the reflector or the umbrellas as shoot-through 
diffusers. Point the lights toward the object and place the diffuser in front of the light source so that 
the light shines through the diffused layer.

a.	 Reflector: Hold the translucent panel between the light stand and the object (Image 19).
b.	 Umbrella: Remove the black cover off each pin and aim the light towards the object. The back of 

the umbrella should be facing the object (Image 20). 

Image 19: A translucent reflector can be held between the light source and the 
object to diffuse light.

Image 20: The umbrella’s black cover can be 
removed to use the white umbrella as a diffuser.
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Image 21: Tripod with adjustable legs, with the added overhead arm on the right.

Camera tripod
For each object, determine which camera angles will be needed based on the type and condition of the object 
and the desired views. For overhead angles, see Overhead photography. See Object placement for generally 
recommended views or Appendix D: Examples for recommendations based on specific types of objects.

Secure the camera to a tripod for clear photographs with no blurring. Changes to the tripod position and 
height during photography will impact post-photography processing. For suggestions on tracking tripod 
changes, see Appendix B: Project documentation.

1.	 Set up the tripod, securing the base (Image 21). 

TIP:  Adjust the height of the tripod after attaching the camera for ease rather than attaching the 
camera after the tripod is fully extended. 

2.	 View the built-in level at the top of the tripod to ensure the tripod is balanced. The bubble should be 
between the two lines when level. (Image 22).

3.	 Screw the tripod mount onto the socket at the bottom of the camera. Ensure the camera battery is 
inserted and mount the camera on the tripod, tightening the knobs to secure it. (Image 23).

TIP: With low shutter speeds, it is very important that the camera is completely still. Securely screw 
the base of the tripod mount onto the tripod or your photographs will be blurry.

Image 22: Built-in level on tripod. Image 23: Attach tripod mount to 
base of camera.
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Image 24: Mount flash trigger on 
camera and lock in place.

4.	 Confirm that the tripod and camera are level using a handheld level. The image can be rotated in post-
photography processing but aim to get the best image possible when shooting.

a.	 The camera will not need to be level for a ¾ angle.
5.	 Mount the flash trigger on the camera and lock it in place (Image 24).

6.	 Adjust the tripod height and distance from the object based on the size and type of the object(s) to be 
photographed. Reconfirm that the tripod and camera are level after any adjustments.

a.	 Readjust the tripod when switching to a different object size and type. Keep the tripod height 
and distance consistent for each group and camera position, i.e. all overhead photographs of the 
same object should be shot from a static position. 

b.	 To determine the height, distance, and photograph views for an object, see Object placement.
7.	 Square or rectangular objects or bound books may be easier to shoot from above. To photograph 

objects from above, see Overhead photography.

TIP:  If needed, handheld photography can be used for smaller objects that require a close-up but 
these photographs are prone to blurs and shakes. Best practice is to use a tripod for photography.

8.	 Next: Camera set-up.
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Overhead photography
For 2D objects like artwork or fragile objects that cannot stand on their own, you can shoot photographs from 
above the object. Some photograph views like interior shots will also require the use of the overhead arm.

WARNING:  Do not adjust overhead arm or mount the camera over top of the object. If adjustments 
need to be made in the middle of a photography session, remove the object before adjusting 
equipment to prevent damage to objects.

1.	 Attach the overhead arm to the tripod if not already connected (Image 21).
2.	 Unlock the dial on top of the tripod centre column and turn the overhead arm parallel to the floor, 

aligning with the 90 degree marker beside the dial. Relock the dial and confirm that the arm is level 
using a standalone level (Images 25 and 26). 

3.	 Unlock the dial on the overhead arm and move arm left or right until centred. Relock the dial (Image 27).
4.	 Raise the tripod height so that no shadows from the arm are cast on the backdrop where the object will 

be placed.
5.	 Attach a sandbag and weight to the hook side of the arm to balance the weight of the camera (Image 28).

a.	 Use 395 grams (1 lb) of weights or more, or measure out 395 grams of rice, beans, or sand.
b.	 Place the weights inside a sealed Ziploc bag before placing it in the sandbag to keep the bag 

clean. 
c.	 Hang the sandbag from the hook.

6.	 Mount the camera to the tripod head and tighten the knobs to secure it. 
7.	 Adjust the arm as needed so that the camera lens is centred over where the object will be. Confirm 

that the camera is level.
8.	 When finished using the overhead arm, remove camera and sandbag weights and return the arm to an 

upright (0 degree) position, reversing the steps above.

Image 25: Unlock dial on top of 
tripod overhead column. 

Image 26: Adjust overhead arm 
parallel to floor at 90 degrees 
and lock in place.

Image 27: Unlock dial on 
overhead arm to centre arm 
over tripod stand and lock in 
place.

Image 28: Overhead 
photography set-up with 
attachment arm positioned 
over table. Use a sandbag and 
weights to balance the weight 
of the camera.
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Tethered capture set-up
Tethered capture is an optional method of using a connected laptop to take photographs, preventing camera 
shake from the shutter and allowing for more accurate review of photographs as they are taken. Photographs 
can be directly uploaded to the laptop, skipping the upload stage.

1.	 Place a desk or table near the tripod for a laptop, taking care to not obstruct the lights or other 
equipment. The desk should not be visible in the photograph.

2.	 With the camera off, connect the laptop to the camera using the USB cable (Images 29 and 30).
3.	 To use the laptop as a remote connection to the camera for capture and reviewing photographs, see 

Tethered capture settings.
4.	 Next: Camera set-up.

Image 29: Connect laptop to camera using USB cable for 
tethered capture.

Image 30: Overall photography set-up with tethered laptop.
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Image 31: Power switch on camera. Image 32: Insert battery when the 
camera is off.

Camera set-up
Confirm the settings on the camera and the tethered laptop for your photography session.

Camera settings
Some camera settings can be adjusted once for an entire photography session while others will need to be set 
for each object and photograph. Some settings will depend on the available lighting, space, and size or type of 
the object being photographed. 

For specific instructions on adjusting camera settings for the Nikon Z50, see Appendix C: Detailed camera 
settings.

When using a tethered capture software without live view support, some camera settings will need to be set 
directly on the camera while others can be set using the tethered laptop. See Tethered capture settings.

1.	 Attach the desired lens to the camera. To use a macro lens, see Appendix A: Equipment list and care.
2.	 Turn the camera on (Image 31).

a.	 Make sure a memory card is inserted and the battery is inserted and fully charged. Only insert 
the battery when the camera is off (Image 32).

TIP:  You can see your battery charge in the bottom left corner of the monitor when the camera is on. A 
spare fully-charged battery is recommended.

3.	 Remove the lens cap. For instructions on cleaning the lens, see Appendix A: Equipment list and care.



28

4.	 Switch the photo/movie selector to Photo Mode to take photographs (Image 33).

Image 33: Set to Photo Mode.

Image 34: Set focal length based on the size 
of the object.

Image 35: Aperture Priority mode.

5.	 Image quality: NEF (RAW)

TIP:  RAW files are ideal for object photography but you can also select NEF (RAW) + JPEG fine. This 
will produce two file formats for every photograph taken if you would like to quickly review JPEGs on 
the computer.

6.	 Bit depth: 14-bit
7.	 Focal length:

a.	 Focal length determines the angle of view and magnification. For larger objects such as kimono 
and paintings, set a focal length of 16. Smaller objects may need a focal length of 24 (Image 34).

b.	 Keep focal length consistent for each size grouping of objects.
c.	 For very small objects or details, a macro lens is recommended. See Appendix A: Equipment list 

and care.

TIP:  Adjust the focal length and the distance of the tripod from the object in order to fill the camera 
frame with the object.

8.	 Mode: Aperture Priority (A) (Image 35)
a.	 Manual mode can also be selected and will require manually setting the shutter speed.
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9.	 Aperture: f8-f11 for 2D objects, variable for 3D objects (Image 36)
a.	 Larger aperture (e.g. f3.5, f4, f5.6) will result in more brightness and blurred background.  
b.	 Smaller aperture (e.g. f8, f11, f16) will have more depth of field and focused background but less 

brightness.
c.	 3D objects may need a smaller aperture than 2D objects for more depth but avoid using the 

camera’s smallest aperture as this will cause a loss of the sharpness in the photograph. The 
smallest aperture on the Nikon Z50 is f22 so avoid using smaller apertures than f16.

TIP:  Test your ideal aperture by taking several photographs of the same object at different aperture 
settings and view the results on a computer. Review for focus and level of detail of the object. Adjust 
aperture as needed to reach appropriate detail.

10.	 Shutter speed: Variable (Image 36)
a.	 In Aperture Priority (A) mode, the camera will automatically select an appropriate shutter speed 

based on the selected aperture and focal length, with no manual ability to adjust the setting. The 
camera will also automatically adjust the shutter speed based on high or low ISO and exposure.

TIP:  Using a tripod is highly recommended for object photography but if you choose to take 
photographs by hand, use a fast shutter speed to avoid motion blurs. Manual mode allows all of the 
settings to be adjusted, including shutter speed. To determine the minimum shutter speed when not 
using a tripod, multiply your focal length by 2 and divide the result into 1, e.g. with a focal length of 16, 
the shutter speed should be at least 1/32.

11.	 ISO: Auto (Image 36)
a.	 Auto ISO will automatically adjust the ISO sensitivity based on the lighting and other settings.

i.	 ISO should be below 400 for handheld photography and below 200 for photographs with a 
tripod.

b.	 Set “ISO sensitivity” to 100 for a minimum and “Maximum sensitivity” to 400.

TIP:  Increase ISO in low light situations but avoid high ISO levels as photographs may become grainy 
or colour-distorted. Ideally, ISO should be as low as possible while still letting in sufficient light.

Image 36: Monitor on Aperture Mode showing shutter speed 
(e.g. 1/25), aperture (e.g. f8), and ISO values (e.g. 100) at bottom.
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12.	 Exposure:
a.	 Adjust exposure to control the brightness of the photograph. Set exposure to 0 or as close as 

possible (Image 37).
b.	 In Manual mode, adjusting the shutter speed will also adjust the exposure.

TIP:  Make sure that the image is not overblown (i.e. exposed to too much light and appears too bright 
or white) as this cannot be fixed in post-photography processing. When in doubt, choose the exposure 
that produces a darker image over a brighter image.

Image 37: Set exposure as close to 0 as possible.

13.	 White balance: Create a custom white balance preset at the beginning of each photography session 
and each time your lighting changes, including changes to the brightness, angle, and distance of the 
lights. To set a custom white balance preset, see Appendix C: Detailed camera settings.

TIP:  White balance can be adjusted in post-photography processing but aim to get the best image 
possible when shooting. Rather than a custom preset, you can also set white balance to Auto or a 
specific colour temperature based on the lighting.

14.	 Live view display: On
a.	 This will ensure that the image on the camera’s monitor screen accurately represents the 

photograph that will be taken. Note: this live view display is different from the live view option 
with tethering software.

15.	 Framing grid display: On (optional)
a.	 The framing grid will help line objects on straight edges for even photographs. When 

photographing kimono, line up the back centre seam of the kimono with the centre vertical line of 
the grid.

16.	 Next: Image capture
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Tethered capture settings
Use a laptop as an external monitor to avoid camera shake from the shutter and to more accurately view 
photographs immediately after shooting. Photographs can be directly uploaded to the computer, skipping the 
upload stage. Some settings will still need to be set on the physical camera.

To set up equipment for tethered capture, see Tethered capture set-up.

1.	 Attach the desired lens to the camera. To use a macro lens, see Appendix A: Equipment list and care.
2.	 Connect the camera to a laptop using a USB cable and turn the camera on.

a.	 Make sure a memory card is inserted and the battery is inserted and fully charged. Only insert 
the battery when the camera is off.

3.	 Remove the lens cap.
4.	 Switch the photo/movie selector on the camera to Photo Mode to take photographs.
5.	        Open the Nikon NX Tether software on the laptop.
6.	 Confirm that the camera name is listed under Record Settings (Image 38).
7.	 Set the destination to Computer + Card to save two copies of each photograph, one to the laptop and 

one to the memory card in the camera (Image 38).
a.	 Click Browse to select a folder or create a new folder on the laptop. Label the folder with an easily 

identifiable name, such as the date of photography and the name of the project or object type, 
e.g. 2023-06 Banno Collection Kimono Photography.

TIP:  You can set the destination to Computer only but consider setting the destination to Computer + 
Card to create a temporary backup copy.

Image 38: Confirm camera record 
settings and set destination for 
photographs.
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8.	 Click Camera in the top menu and select Enable Controls on Camera Body (Image 39).

TIP:  If you are using a tethering software with live view support, you can disable controls on the 
camera as you will be able to view the live image and control focus directly on the computer.

Image 39: Enable controls on camera body.

Image 40: Open the Options panel.

Image 41: Set Software to View Pictures After Transfer to 
Photoshop or another photo editing software.

9.	 Click Tools > Options in the top menu (Image 40).
a.	 Select the Destination tab and set Software to View Pictures After Transfer to Photoshop. If this 

is the first time Photoshop has been opened through NX Tether, select Register App and choose 
Photoshop from the applications available on the computer (Image 41).

b.	 Optionally, set the file name for each image based on your organization’s naming conventions.

TIP:  If you are photographing objects from multiple collections, it will be easier to rename the 
photographs during post-photography processing. Remember to include the physical object number in 
the photograph when shooting for easy reference when renaming.
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10.	 Shooting settings: Mode, shutter speed, aperture, ISO, exposure, and white balance settings can be 
set or confirmed in NX Tether (Image 42).

a.	 Mode: Mode can only be set on NX Tether if controls on the camera body are disabled. If controls 
are enabled, turn the mode dial on the camera to A or M. If controls are disabled, click the mode 
box in NX Tether and select Aperture Priority or Manual mode.

b.	 Shutter speed: Shutter speed will be set automatically when in Aperture Priority mode. If using 
Manual mode, click the shutter speed box and use the arrows to set a desired speed.

c.	 Aperture: Click the aperture box and use the arrows to set aperture. 
d.	 ISO: Set ISO sensitivity settings directly on the camera. In NX Tether, click the ISO button and 

confirm ISO is below 400.
e.	 Exposure: Click the exposure button and use the arrows to adjust the exposure value to as close 

to 0.0 as possible. When in doubt, choose the exposure that produces a darker image over a 
brighter image.

f.	 White balance: Create the white balance preset for the photography session directly on the 
camera. In NX Tether, confirm that the preset created for the session is selected.

g.	 The selected settings will appear in the display bar at the top of the window (Image 43).
i.	 If a camera is not connected, the bar will appear red with empty values.
ii.	 When downloading images to the computer, the bar will show the number of images remaining 

to download.

11.	 Image quality, bit depth, and focal length will need to be set directly on the camera. 			 
See Camera settings.

12.	 Autofocus: Turn On by clicking the AF button at the top of the window (Image 44).
13.	 View the camera’s battery level in the top right corner of the window. A warning will be displayed when 

the battery needs to be charged (Image 44).

14.	 Next: Image capture

Image 42: Set shooting settings for photographs. Image 43: Display bar with shooting settings.

Image 44: Turn on Autofocus and view 
battery level to see charge.
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Image capture
Place the objects in the photography space and proceed with taking your photographs.

Object placement
Once the photography equipment and camera are ready, determine the necessary photograph views and 
arrange the object, scale, and colour target to prepare for photography. 

For recommendations based on the specific type of objects you are photographing, see Appendix D: 
Examples.

TIP:  When determining photograph views, check the back or base of the object for details that should 
be captured, such as a maker’s mark. Properly support the object if placing it upside down or on its side.

1.	 Place the object to be photographed on the table, base, or stand, or inside the lightbox. Avoid large 
shadows on the backdrop by placing the object in the middle of the table or by moving the object 
stand forward away from the backdrop.

2.	 For 2D objects like framed photographs or paintings, arrange the object so it is parallel to the camera, 
standing upright on an easel or laid flat for overhead photography. Photograph the back of framed 
items or paintings and capture details with close-up views as needed.

a.	 Recommended photograph views for 2D objects include:
i.	 Front view
ii.	 Back view
iii.	Detail views as needed, i.e. for a small intricate design or a signature

3.	 For 3D objects, arrange the object for multiple views as needed to capture any necessary details and 
components. Some views will require the use of the overhead arm (Images 45 and 46). 

a.	 Recommended photograph views for 3D objects include: 
i.	 Front view
ii.	 Three-quarter view: use a three-quarter camera angle for ¾ views. Position the camera in front 

of the object and raised slightly above, pointed downwards. Place the object at an angle to the 
camera so the front, side, and top are all partially visible. ¾ views should have the same lighting 
as other views of the same object for post-photography processing (Image 45).

iii.	Back, bottom, or interior views if applicable and as needed
iv.	 Detail views as needed, i.e. for a small intricate design or a signature

Image 45: Front view, ¾ view, and interior view of object. Place the scale and colour target in the 
midline of the object, parallel to the camera. The scale and colour target are optional for ¾ views as 
long as the lighting is unchanged.

Image 46: Detail view of object 
showing maker’s mark on base.
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b.	 If an object can safely open (e.g. a purse or basket), show the object open in the ¾ view and 
closed in other views. 

c.	 If the object has multiple components that can safely be taken apart (e.g. a bowl with a lid), one 
of the views should show the components taken apart (Image 47).

TIP:  The condition of the object can also be captured with object photography. In addition to the 
recommended views above, document any damage or degradation to the object, i.e. scratches, tears, 
or chips, and make note of the location and size of the damage in the project documentation or the 
object metadata. 

Image 47: Front/components view and ¾ view of object with multiple components.

Image 48: Use a colour target for accurate colours in the final photograph. 
Ensure the neutral gray square is clearly displayed.

4.	 Place a metric scale and colour target beside the object. 
a.	 The scale and colour target will be used to accurately represent the size and colour of the object. 

Display the side of the colour target with the neutral gray square (Image 48).
b.	 The scale and colour target are optional for ¾ and detail views, as long as the lighting for 

these views is unchanged from other photographs of the same object. The tripod distance for 
¾ views should remain unchanged from other photographs. Colour edits can be copied from 
photographs that have the colour target in place and the scale of the object can be determined 
from photographs with the scale in place.

TIP:  Each gray square on a colour target has different colour values. For colour corrections, we will use 
the neutral gray square that has an RGB value of 120 +/- 5 in the Adobe RGB (1998) colour space. This is 
the 4th square from the left on the bottom row of the colour target. Ensure this side of the colour target 
is visible in the photograph. For more on how the target is used in post-photography processing, see 
Colour corrections.
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c.	 Place the scale and target parallel to the camera lens and in the midline of the object’s depth 
(i.e. centered between the closest and furthest part of the object from the camera), with enough 
distance from the object so that they can be cropped out in post-photography processing if 
desired (Image 45). 
i.	 For photographs taken with straight on angles, place the scale and colour target on a stand so 

they are parallel to the camera. When photographing large objects that do not require a table, 
place the scale and colour target on a stand or table to the side of the object. For overhead 
angles, the scale and colour target can be placed flat beside the object.

d.	 Include the object’s unique identifier (e.g. accession number) within the photograph for ease of 
tracking. Write the accession number on the scale with a dry-erase marker. Erase and rewrite the 
number for each new object (Image 49).

WARNING:  Avoid touching the swatches on the colour target as the oils from your hands will 
discolour the swatches over time and they will not represent the accurate colours. Keep the target clean 
and out of the light when not in use.

Image 49: Display the object’s accession number within 
the photograph for easy tracking.

5.	 Once the objects are prepared, turn on the lights and adjust the height, distance, and brightness of 
the lights as needed.

a.	 Set a new custom white balance preset if any changes were made to the lighting position or 
power. Tethered capture will need to be temporarily disconnected to set white balance.

TIP:  Set up the photograph as much as possible before turning on the lights to avoid leaving the 
object(s) under direct light for long periods. Turn off the lights when you are not using them, such as 
when you are preparing the next group of objects for photography. Avoid turning them on and off 
frequently to prolong the life of the lights.
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6.	 Adjust the height of the tripod based on the object. The camera lens should come to the middle of the 
object.

a.	 For ¾ angles, the camera is raised slightly above the object and pointed at an angle downwards 
to show the depth of the object (Image 50).

7.	 Turn on the camera.
8.	 Fill the frame of the camera with the object, adjusting the camera orientation and the distance of the 

tripod from the object to allow the object to appear as large as possible. Ensure the scale and colour 
target are also visible in the frame (Image 50).

9.	 Next: Taking photographs

Image 50: The object should fill the frame of the camera, along with the scale and colour target if 
used. For ¾ angles, the camera is raised slightly above the object and pointed downwards while 
the straight on angle is level and pointed straight ahead. Use of the scale and colour target is 
optional as long as the lighting and tripod distance is unchanged from other photographs of the 
same object.
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Taking photographs
Take photographs of the objects and review the results to check whether any settings or equipment should be 
adjusted.

Tethered capture shooting
Use a laptop as an external monitor to avoid camera shake from the shutter and to more accurately view 
photographs immediately after shooting. Photographs can be directly uploaded to the computer, skipping the 
upload stage.

To set up the equipment and camera for tethered capture, see Tethered capture set-up and Tethered capture 
settings. 

TIP:  Make note of changes to camera angle and position and lighting power and position between 
photograph views of the same object, as changes will impact post-photography corrections. For 
suggestions on how to track equipment and setting changes for post-photography processing, see 
Appendix B: Project documentation.

1.	 Confirm framing and focus is clear on the object by taking a sample photograph.
2.	 When ready to take a photograph, click the shutter-release button at the top of the screen (Image 51).

Image 51: Click the shutter-release button to 
take a photograph.

3.	 Photoshop will open to display the photograph. Review the photograph to ensure appropriate detail 
has been captured and adjust camera settings and lighting as needed.

4.	 Take photographs of the object from multiple views as needed, with the scale and the colour target 
in the frame. See Object placement for generally recommended views or Appendix D: Examples for 
recommendations based on specific types of objects.

5.	 Move the object(s) rather than the equipment to capture different views. Keep the tripod and light 
stands at a consistent distance and height for each shot of the same object. For objects that require 
both straight on and overhead angles, keep the tripod and light stands consistent for each camera 
angle. 

WARNING:  If the object being photographed is fragile, adjust your views accordingly to prevent 
further damage to the object. In these cases, it may be better to move the equipment to prevent 
potential risk to the object.
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6.	 Once finished taking photographs, retract the lens by rotating the zoom ring until it clicks closed and 
replace the lens cap. 

7.	 Disconnect from NX Tether by clicking Disconnect beside the camera name under Record Settings. 
Turn off the camera and unplug the USB cable (Image 52).

8.	 Next: Post-photography processing

Manual capture shooting
If tethered capture is not possible, you may manually press the shutter button and access photographs directly 
on the camera.

TIP:  Make note of changes to camera angle and position and lighting power and position between 
photograph views of the same object, as changes will impact post-photography corrections. For 
suggestions on how to track equipment and setting changes for post-photography processing, see 
Appendix B: Project documentation.

1.	 Confirm framing and focus is clear on the object by looking at the monitor screen.
2.	 When ready to take a photograph, press the shutter-release button down halfway for the camera to 

focus. The focus point(s) will be displayed as green boxes (Images 53 and 54).

TIP:  If boxes do not appear in green, you will be unable to take a photograph. Release the shutter-
release button and try again.

Image 53: Shutter-release button. Image 54: Focus points on monitor.

Image 52: Disconnect camera from NX Tether.
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3.	 Press the shutter-release button all the way down to take the photograph.
a.	 The memory card access lamp on the back of the camera will light after the photograph is taken. 

Do not remove the memory card or battery from the camera until the light has gone out (several 
seconds) (Image 55).

4.	 Playback: press the playback button to review the photograph (Image 56).
a.	 Use the zoom buttons on the monitor to ensure appropriate detail has been captured (Image 57).
b.	 To delete any photographs, press the trash can button and follow the prompts (Image 58).

5.	 Take photographs of the object from multiple views as needed, keeping the scale and the colour target 
in the frame for all views except detail and ¾ views. See Object placement for generally recommended 
views or Appendix D: Examples for recommendations based on specific types of objects.

6.	 Move the object rather than the equipment to capture different views. Keep the tripod and light stands 
at a consistent distance and height for each shot of the same object. For objects that require both 
straight on and overhead angles, keep the tripod and light stands consistent for each camera angle. 

WARNING:  If the object being photographed is fragile, adjust your views accordingly to prevent 
further damage to the object. In these cases, it may be better to move the equipment to prevent 
potential risk to the object

Image 55: Memory card access lamp. Image 56: Playback button.

Image 57: Zoom in and out on the photographs. Image 58: Delete button.

7.	 Once finished taking photographs, retract the lens by rotating the zoom ring until it clicks closed and 
replace the lens cap. 

8.	 Turn off the camera.
9.	 Next: Transfer photographs to computer
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Transfer photographs to computer
1.	 If photographs were not saved directly to a computer during tethering, upload photographs to the 

computer.
a.	 While the camera is off, connect the camera to the computer using the USB cable. Turn the 

camera on (Image 59).
b.	 In File Explorer, open the Z 50 folder under “This PC” (Image 60).
c.	 Copy all photographs to a new folder on the computer. Once successfully copied, delete the 

photos from the camera’s memory card. Label the folder with an easily identifiable name, such 
as the date of photography and the name of the project, e.g. 2023-06 Banno Collection Kimono 
Photography.

d.	 Turn off the camera and disconnect the USB cable.

Image 59: Connect camera to computer using USB cable. Image 60: Z 50 Folder on computer.

2.	 Remove the battery once photography is finished for the day and plug it into the charger for the 
next day.

3.	 Next: Post-photography processing
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Post-photography processing
Prepare the photographs for long-term preservation and complete any needed corrections on access copies.

Creating preservation files
Create TIFF preservation files from the RAW images for long-term preservation.

1.	 Rename the RAW images with the accession number as the file name, e.g. 2001-8-7-1.
a.	 For objects with photographs of multiple views, label the files as v1, v2, v3 etc., 			 

e.g. 2001-8-7-1v1.NEF.
b.	 For photograph albums, see File names for albums. 

2.	 Open the RAW image in Photoshop and save as a TIFF file with the same accession number file name. 
This will be the preservation file (Image 61).

3.	 Optional: RAW files can be discarded at the end of the project but should be retained until all post-
photography processing is complete and file backups are confirmed.

4.	 Next: Editing the photograph: Image adjustments vs. corrections

Image 61: File > Save As on Photoshop.
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Editing the photograph: Image adjustments vs. corrections
Post-photography edits to the digital file are completed in two stages. 

1.	 Adjustments: 
a.	 Edits only include rotation of the image and cropping of the border. 
b.	 Adjustments can be completed on the preservation file.
c.	 See Image adjustments.

2.	 Corrections: 
a.	 Edits may include colour correction, white balance, dust removal, editing to recreate losses on the 

object such as cracks in a vase, and removing backgrounds.  
b.	 Corrections can be completed on the primary access copy.
c.	 See Image corrections and primary access copies.

Image adjustments
Post-photography adjustments on the preservation file only include rotation of the image and cropping of the 
border. 

1.	 Open the preservation file in Adobe Photoshop or Photoshop Elements.
2.	 Rotate the image so it appears upright: “Image” > “Rotate” > left or right (Image 62).

Image 62: Rotate and level.

3.	 Adjust the image so it is level: 
a.	 In Photoshop Elements: “Image” > “Rotate” > “Custom” and adjust by degree to the left or 

right, e.g. 0.5 degrees to the right 
b.	 In Adobe Photoshop: “Image” > “Image Rotation” > “Arbitrary” and adjust by degree clockwise 

or counter clockwise, e.g. 0.5 degrees clockwise

TIP:  You can also use the straightener tool in Photoshop to adjust the image. Do not use the 
straightener tool in Elements as it will convert the file to 8-bit. 
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Image 64: Fit on screen.

Image 65: Apply Adobe RGB Profile (PSE).

Image 63: Crop leaving a border around the image.

Image 66: Convert colour profile to Adobe RGB (1998) (PS).

4.	 Crop the image and leave a border around the original object (Image 63). 

TIP:  Select Ctrl+0 to fit the entire image on your screen before cropping (Image 64).

5.	 Assign the colour profile to Adobe RGB (1998).
a.	 In Photoshop Elements: “Image” > “Convert Color Profile” and select “Apply Adobe RGB Profile” 

if not already selected (Image 65).
b.	 In Adobe Photoshop: “Edit” > “Convert to Profile” and set the Destination Space Profile to 

“Adobe RGB (1998)” > click “OK.” (Image 66).
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6.	 Click “File” > “Save As” to resave the file as a high resolution TIFF (no compression), replacing the 
unedited TIFF file (Images 67 and 68).

WARNING:  Any other post-photography edits such as colour correction, white balance, etc. are not 
completed on the high resolution preservation file. See Image corrections and primary access copies.

7.	 Next: Checking your work

Image 68: Save as TIFF options.Image 67: File > Save As.
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Checking your work
Check the properties of the files you have created to confirm that they meet archival standard requirements.

1.	 Check your work at a glance in File Explorer.
2.	 Once preservation TIFF files have been created, open the folder where they are saved.
3.	 Click View in the top toolbar and select “Details” view.
4.	 Right click on any of the column titles and select “More” from the dropdown menu (Image 69).

5.	 In the “Choose Details” screen, click to add checkmarks beside “Bit Depth”, “Dimensions”, and 
“Horizontal Resolution”.  Click “OK” at the bottom of the screen. These details will now show up as 
columns in File Explorer. (Images 70 and 71)

Image 69: Details view dropdown.

Image 70: Choose details.

Image 71: Checking work new columns.
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6.	 Confirm that the details for the files are correct:
a.	 Bit depth should be 24-bit.
b.	 Horizontal resolution should be 300 dpi.
c.	 Minimum of 4000 pixels on the longest side of the image.

TIP:  The largest size of RAW files that can be created with the Nikon Z50 camera is 3728 x 5600 pixels. 
TIFFs should be around this size.

7.	 If any details do not meet the instructions above, retake the photographs.
8.	 Next: Image corrections and primary access copies
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Image 72: Photoshop PAC copy.

Image corrections and primary access copies
Post-photography corrections on the primary access copy file may include colour correction, white balance, 
dust removal, and editing to recreate losses in the image such as tears. 

Creating primary access copies
Create TIFF primary access copies from preservation files to perform corrections to images.

1.	 Open the TIFF preservation file in Adobe Photoshop or Photoshop Elements. 
2.	 Save As to create a high resolution primary access copy. Add -pac to the end of the file name, e.g. 

2001-8-7-1v1-pac.tif (Image 72).
3.	 Any post-photography edits such as colour correction, white balance, and removing the background 

should only be completed on the primary access copy.
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Colour corrections
Edit the colours of the photograph based on the colour target for more accurate colour representation of the object.

The instructions for colour corrections below are based on Adobe Photoshop.

1.	 Open the TIFF primary access copy in Adobe Photoshop.
2.	 Open the INFO panel: Window > Info (Image 73).

a.	 Click the four lines in the top right corner of the panel and select Panel Options. Set the “First 
Color Readout” mode to “RGB Color” and click “OK” (Image 74).

TIP:  You can also open the INFO panel by clicking the “i” button on the right toolbar. You can move 
the panel around your screen as best suits your work.

Image 73: Open the INFO panel.

Image 74: Select Panel Options to change mode to RGB Color.



50

3.	 Zoom in on the image so the neutral gray square on the colour target is clearly visible. Do not magnify 
beyond 100%.

TIP:  Each gray square on a colour target has different colour values. For colour corrections, we will use 
the neutral gray square that has an RGB value of 120 +/- 5 in the Adobe RGB (1998) colour space (Image 75).

4.	 Select the “Eyedropper Tool” in the left menu (Image 76).
a.	 Set Sample Size in the top menu to “5 by 5 Average” (Image 76). 

5.	 Using the eyedropper tool, mouse over the neutral gray square on the colour target. Press Shift and 
click on the neutral gray square to create a sample (#1) that will be saved in the INFO panel (Image 77).

TIP:  You can create multiple samples by clicking other areas of the image. To remove samples, press 
Alt + Shift until a scissors icon appears and click on the sample that you wish to remove. 

Image 75: The neutral gray square on the colour target will be used for colour corrections. 

Image 76: Eyedropper tool and sample size of 
5 by 5 Average.

Image 77: Create a sample with the eyedropper tool to 
view the RGB values of the neutral gray square. Review 
values in the INFO panel to determine corrections needed.
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6.	 Review the INFO panel. 
a.	 The red (R), green (G), and blue (B) values of the neutral gray square sample should be around 

120 RGB +/- 5 and be approximately equal in value or as close as possible. 
b.	 If the RGB values are not around 120 RGB, the exposure will need to be corrected. 
c.	 If the RGB values are not neutral or approximately equal, the colour balance will need to be 

corrected.

In this example, the green and blue values of the neutral gray are 140 and the red value is 147. To colour 
correct the image, the exposure will need to be edited to get the values closer to 120 RGB and the 
colour balance will need to be edited to get the red channel value closer to the green and blue values 
(Image 77).

7.	 Select Ctrl+0 to fit the entire image on the screen.
8.	 Exposure: 

a.	 In the Layers panel, click the Create New Fill or Adjustment Layer icon and select “Exposure” 
(Image 78). A new Exposure layer will be automatically created in the Layers panel.

Image 78: Click the Create New Fill or Adjustment Layer icon and select Exposure.
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b.	 Drag the slider on the Exposure bar to increase or decrease exposure, viewing the changes to the 
neutral gray square sample values in the INFO panel. Drag the slider until the lowest or middle 
RGB value reaches 120 +/- 5, increasing exposure for values below 115 RGB and decreasing 
exposure for values above 125 RGB (Image 79).

c.	 Review the original and edited values in the INFO panel. The first value is the original value and 
the second value is the edited value (e.g. R: 147/128) (Image 80).

In the example, decreasing the exposure brings the green and blue values within 120 +/- 5 but the 
unequal red colour channel still needs to be corrected by colour balancing.

Image 79: Increase or decrease exposure with the slider.

Image 80: Review changes to RGB values in the INFO panel.
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9.	 Colour balance:
a.	 In the Layers panel, select the image layer or Background layer. Click the Create New Fill or 

Adjustment Layer icon and select “Curves” (Image 81). 
b.	 Drag the Curves layer above the Exposure layer (Image 82).

TIP:  Layers are arranged in a stack in the layers panel. Reordering the Curves layer above the Exposure 
layer ensures that the edited RGB values remain visible in the INFO panel when editing the colour balance.

Image 81: Create a Curves adjustment layer.

Image 82: Reorder the layers with the Curves layer on top.
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c.	 In the Curves layer Properties panel, select the red, green, or blue value that needs to be 
corrected from the dropdown menu. If multiple values need to be corrected, select one to begin. 
Edit the highest RGB value rather than increasing the lower values (Image 83).

d.	 In the histogram, click the middle of the diagonal line and drag it up or down until the selected 
colour value is as close to 120 and the other RGB values as possible (Image 84).

e.	 Review the original and edited values in the INFO panel. The value on the left is the original value 
and the value on the right is the edited value.

f.	 Edit other colour channels as needed, following the same process. Click OK to set the updated 
RGB values.

In the example, the red, green, and blue values are now all 122 after editing exposure and colour 
balance.

Image 83: In the Properties panel, select the colour channel 
from the dropdown menu to the left of the Auto button 
and review histogram.

Image 84: Drag the centre of the diagonal line up or down 
to edit the colour channel value. Edits are reflected in the 
INFO panel.
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TIP:  Rather than edit individual colour channels (as outlined above in Step 9), you can use the white 
balance tool to quickly edit colour balance. Open the Curves layer and reorder it above the Exposure 
layer. Magnify the image up to 100% so the neutral gray square on the colour target is clearly visible. 
Select the Set Gray Point eyedropper and click on the neutral gray square on the colour target. The 
colour balance will be automatically corrected on the image. You can make further edits as needed to 
individual colour channels by editing the histogram following the instructions above (Image 85). 

10.	 Review the RGB values of the image and confirm that the colours look balanced to the eye. If the image 
is still unbalanced, open the Exposure or Curves tool again to make further edits (Image 86).

TIP:  In the layers panel, click the eye icon beside the layers to change visibility and compare the corrections 
to the original image. Use your best judgement when determining if the colour corrections reflect the true 
colour of the object. The values do not need to be exactly 120 or exactly equal to each other. 

Image 85: Use the Set Gray Point eyedropper to quickly edit colour balance instead of editing individual colour channels.

Image 86: Original image on the left and colour-corrected image on the right.

11.	 Once edits are finalized and the visibility of all layers is turned on, under File, click on Save As.
a.	 Select the folder.
b.	 Rename the file as the accession number-view-pac if not already done (pac=primary access copy).

12.	 Next: Duplicating colour corrections.



56

Duplicating colour corrections
Copy colour corrections to all photographs of the same object shot with the same lighting and tripod position.

The instructions for duplicating colour corrections below are based on Adobe Photoshop.

1.	 Open the colour-corrected TIFF and the other TIFF primary access copies for the same object shot 
with the same lighting and tripod position in Adobe Photoshop.

a.	 Each file should appear as a tab with the file name along the top of the photographs. Click the 
tabs to switch between them (Image 87).

2.	 Click the tab with the colour-corrected TIFF, drag the window down and release so it appears as a 
smaller window in front of the remaining tabs. The window will remain in front when clicking on other 
tabs (Image 88).

Image 87: Open the colour-corrected TIFF and the other TIFF primary access copies of the same 
object in Photoshop. Open files will appear as tabs at the top of the window.

Image 88: Drag the colour-corrected file window in front of the other windows so it appears as a 
small pop-up.

3.	 With the colour-corrected file selected, select both the Exposure and Curves layers from the Layer 
panel by clicking a layer and holding the Shift key to select the other layer. If only one edit was applied, 
select the single layer. Drag the layer selection into the window of the uncorrected file (Image 89).
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4.	 The layers will now appear in the Layer panel of the second photograph and the edits will automatically 
be applied (Image 90).

5.	 Repeat as needed with the remaining object files by following the same steps to copy the corrections 

Image 89: Select all edited layers from the colour-corrected photograph and drag into the 
uncorrected photograph window.

Image 90: Confirm that the layers appear in the Layer panel of the second object photograph.

from the colour-corrected photograph.
6.	 Save each file, ensuring they are saved as the accession number-view-pac.

TIP:  You can make individual edits to each file instead of copying the corrections but this will take 
longer and you may have slight differences in exposure and colour balance. If lighting or camera 
position was changed for any photographs, these will need individual edits. For suggestions on how to 
track equipment and setting changes to aid in post-photography processing, see Appendix B: Project 
documentation.

7.	 Next: Removing background (optional) or Creating derivative access copies.
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Removing background
Optionally, remove the background of the photographs to create a uniform white background for access copies.

Steps for Adobe Photoshop Elements

1.	 Open the TIFF primary access copy in Adobe Photoshop Elements. See Creating primary access 
copies.

2.	 In the Layers panel, double click the lock icon to unlock the first layer. Name “Layer 0” and click OK 
(Image 91).

3.	 Once unlocked, click on “Quick Selection Tool” in the left menu (Image 92).
4.	 Click on the “+” button in the tools setting menu at the top of the screen (Image 93).
5.	 Specify the brush details (Image 93):

a.	 Set the size using Diameter. This will depend on the size of the object. If there are many small 
edges, make the brush smaller (e.g. 7 px). If the edges are long and smooth, use a larger brush 
size (e.g. 30 px).

b.	 Set the Hardness to 1%.
c.	 Set Spacing to 20%.
d.	 Set Angle to 0%.
e.	 Set Roundness to 100%.
f.	 Ensure Size is set to Off.

6.	 Uncheck “All Layers” and “Auto-Enhance” (Image 93).

Image 91: Unlock layer (PSE). Image 92: Select 
“Quick Selection Tool” 
(PSE).

Image 93: Quick Selection Tool menu (PSE).

7.	 Using the mouse, click and hold over the image. Trace the edges and ensure that the whole object is 
covered. Photoshop will automatically snap to the edges to select it.

a.	 If it selects parts not included in the object, press and hold the Alt key and brush over these parts 
to deselect with the mouse.

TIP:  Selecting the whole object will take time and some fiddling with. Don’t rush as you work through 
this step.
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8.	 Once the object is outlined (don’t forget to capture any holes in the object), click on “Refine Edge” in 
the top menu (Image 94).

a.	 Smooth the outline so the edge has minimal bumps by dragging the Smooth slider bar.
b.	 Set Feather to 0.0.
c.	 Adjust the Contract/Expand so the outline is slightly bigger than the object. This will depend on 

the initial outline. Ensure that the edges of the object are not cut off.
d.	 Click OK.

9.	 Right click the selection and click on “Layer via Cut”. Two layers will appear in the layer panel, one of 
the background (Layer 0) and one of the object (Layer 1). 

TIP:  Click the eye to change visibility for each layer. View only the background Layer 0 to ensure the 
entire object has been cut out. View only the object Layer 1 to ensure the object’s edges are accurate. 
If any edits to the outline are needed, simply undo (CTRL+Z) the “Layer via Cut” to return to edit the 
outline. If no parts are missing and the object Layer 1 contains the whole object, proceed to the next 
step.

10.	 In the Layers panel, add a New Layer and name it Layer 2. Drag Layer 2 below the object Layer 1 
(Image 95).

11.	 Select the Paint Bucket tool in the menu on the left. Click on the Select Foreground Colour box and 
select pure white (#ffffff). Ensure Layer 2 is selected and click on the background with the paint bucket 
(Image 96).

Image 94: Refine Edge menu and example (PSE).

Image 95: Add New Layer and rearrange (PSE). Image 96: Paint bucket tool and foreground 
colour selected as white (PSE).



60

12.	 Double check that no pieces of the object were left behind in Layer 0 and delete this layer. There 
should now only be the object Layer 1 and Layer 2 with the white background, and any layers from 
colour correction edits.

13.	 Under File, click on Save As to resave the file, replacing the old primary access copy file (Image 97).
a.	 Select the folder.
b.	 Rename the file as the accession number-view-pac if not already done (pac=primary access copy).
c.	 Check the “Layers” box, uncheck “As a Copy” (Image 97).
d.	 Click Save. A TIFF Options panel will appear. 

i.	 Set Image Compression to none.
ii.	 Set Pixel Order to Interleaved (RGBRGB).
iii.	Set Byte Order to IBM PC (or Macintosh if using an Apple device).
iv.	 Uncheck Save Image Pyramid and Save Transparency.
v.	 Set Layer Compression to RLE (faster saves, bigger files).
vi.	Click OK.

Image 97: Save As box and TIFF Options panel (PSE).

14.	 Next: Creating derivative access copies
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Steps for Adobe Photoshop

1.	 Open the TIFF primary access copy in Adobe Photoshop. See Creating primary access copies.
2.	 In the Layers panel, click the lock icon to unlock the first layer (Image 98). Layer will be automatically 

renamed to “Layer 0”.
3.	 Once unlocked, click on “Quick Selection Tool” in the left menu (Image 99).

Image 98: Unlock layer (PS).

Image 100: Quick Selection Tool menu (PS).

Image 99: Select 'Quick Selection Tool” (PS).

4.	 Click on the “+” button in the tools setting menu at the top of the screen (Image 100).
5.	 Specify the brush details (Image 100):

a.	 Set the size using Diameter. This will depend on the size of the object. If there are many small 
edges, make the brush smaller (e.g. 7 px). If the edges are long and smooth, use a larger brush 
size (e.g. 30 px).

b.	 Set the Hardness to 1%.
c.	 Set Spacing to 20%.
d.	 Set Angle to 0%.
e.	 Set Roundness to 100%.
f.	 Ensure Size is set to Off.

6.	 Uncheck “Sample All Layers” and “Enhance Edge” (Image 100).
7.	 Using the mouse, click and hold over the image. Trace the edges and ensure that the whole object is 

covered. Photoshop will automatically snap to the edges to select it.
a.	 If it selects parts not included in the object, press and hold the Alt key and brush over these parts 

to deselect with the mouse.

TIP:  Selecting the whole object will take time and some fiddling with. Don’t rush as you work through 
this step.
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8.	 Once the object is outlined (don’t forget to capture any holes in the object), click on “Select and Mask” 
in the top menu (Image 101).

a.	 Set Radius to 0.
b.	 Smooth the outline so the edge has minimal bumps by dragging the Smooth slider bar.
c.	 Set Feather to 0.0
d.	 Set Contrast to 0%.
e.	 Adjust Shift Edge so the outline is slightly bigger than the object. This will depend on the initial 

outline. Ensure that the edges of the object are not cut off.
f.	 Click OK.

9.	 Right click the selection and click on “Layer via Cut”. Two layers will appear in the layer panel, one of 
the background (Layer 0) and one of the object (Layer 1). 

TIP:  Click the eye to change visibility for each layer. View only the background Layer 0 to ensure the 
entire object has been cut out. View only the object Layer 1 to ensure the object’s edges are accurate. 
If any edits to the outline are needed, simply undo (CTRL+Z) the “Layer via Cut” to return to edit the 
outline. If no parts are missing and the object Layer 1 contains the whole object, proceed to the next 
step.

10.	 In the Layers panel, add a New Layer and name it Layer 2. Drag the Layer 2 below the object Layer 1 
(Image 102).

11.	 Select the Paint Bucket tool in the menu on the left. Click on the Select Foreground Colour box and 
select pure white (#ffffff). Ensure Layer 2 is selected and click on the background with the paint bucket 
(Image 103).

Image 101: Select and 
Mask menu (PS).

Image 102: Add New Layer and rearrange (PS).

Image 103: Paint Bucket 
tool and foreground colour 
selected as white (PS).
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12.	 Double check that no pieces of the object were left behind in Layer 0 and delete this layer. There 
should now only be the object Layer 1 and Layer 2 with the white background, and any layers from 
colour correction edits.

13.	 Under File, click on Save As to resave the file, replacing the old primary access copy file (Image 104).
a.	 Select the folder.
b.	 Rename the file as the accession number-pac if not already done (pac=primary access copy).
c.	 Click Save. A TIFF Options panel will appear. 

i.	 Set Image Compression to none.
ii.	 Uncheck Save Image Pyramid and Save Transparency.
iii.	Set Pixel Order to Interleaved (RGBRGB).
iv.	 Set Byte Order to IBM PC (or Macintosh if using an Apple device).
v.	 Set Layer Compression to RLE (faster saves, bigger files).
vi.	Click OK.

14.	 Next: Creating derivative access copies

Image 104: Save As box and TIFF Options panel (PS).
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Creating derivative access copies
A high resolution primary access copy is first created from duplicating the preservation file. A derivative access 
copy is created from the primary access copy after image adjustments and corrections for purposes of access 
such as viewing, printing, thumbnails, website, etc. Derivative copies will often be in a lower resolution and in 
an accessible file format (e.g. JPEG, PDF, etc.). 

Based on user needs or custom requests, create higher quality derivative copies by increasing the resolution 
and pixel dimensions.

Batch creation with FastStone Photo Resizer
Use FastStone to convert the edited TIFF files into JPEG derivative access copies in large batches rather than 
individually, speeding up the process.

1.	        Open FastStone Photo Resizer
2.	 Select the folder containing the primary access TIFF files that need to be resized to JPEGs.
3.	 Batch convert by clicking “Add All” to add all TIFF files into the Input List (Image 105).

TIP:  You can also drag and drop files from the computer into the Input List.

4.	 Select JPEG format (*.jpg) as the Output Format.
5.	 Select “Settings” (Image 106).

a.	 Quality scale: 85
b.	 Colour subsampling: High
c.	 Keep EXIF/IPTC Data.

6.	 Check the “Output Folder” box and select a folder for the JPEGs to save to.
7.	 Check the “Use Advanced Options (Resize…)” box and select “Advanced Options”.

Image 105: Add files. Image 106: JPEG settings.
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8.	 Advanced options: select “Resize” and check the “Resize” box (Image 107).
a.	 Resize based on one side.
b.	 Predefined side > Long side.
c.	 Exactly = “900” (Resize photographs to be 900 pixels on their longest side).
d.	 Bicubic filter.

Image 107: Advanced options resize.

Image 109: Advanced options DPI.Image 108: Advanced options colour depth.

9.	 Advanced options: select “Colour Depth” and check the “Change Colour Depth” box (Image 108).
a.	 16.7 Million (24-bit).

10.	 Advanced options: select “DPI” and check the “Change DPI” box (Image 109).
a.	 Enter 100 for both the X-DPI and the Y-DPI.
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Image 110: Advanced options text.

11.	 Advanced options: select “Text” and check the “Add Text” box (Image 110).
a.	 Insert text: 

		  Source: Nikkei National Museum, ($C2)
		  www.nikkeimuseum.org 

b.	 Insert variable ($C2) = file name without the file extension. Add this if the file name is the 
accession number.

c.	 Set the font to Arial, normal, 10.
d.	 Set font colour to black.
e.	 Position bottom left and opacity is 100.

TIP:  The text will appear as a footer on the JPEG image. Insert text that will appropriately identify the 
item, such as your institution’s name, accession number of the item, name of the collection, and your 
institution’s webpage if desired. FastStone Photo Resizer’s other features include adding a watermark, 
border, and more.

12.	 Click “OK”.
13.	 Next: Save your files

http://www.nikkeimuseum.org
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Manual creation
Alternatively, manually create derivative access copies by individually saving each edited TIFF as a JPEG. This 
may be a better option if there are few object photographs to convert.

Steps for Adobe Photoshop Elements

1.	 Save TIFF image as a JPEG to create a derivative access copy. 
2.	 Open TIFF and under File, click Save As.
3.	 Select JPEG as the format and save the file with the accession number as its file name, e.g. 2001-8-7-

1v1.jpeg (Image 111). 

4.	 Click Save and a JPEG Options panel will appear (Image 112).
a.	 Set Quality to a minimum of 9 or High.
b.	 Set Format Options to Baseline (“Standard”).
c.	 Click OK.

Image 111: Save As a copy of the TIFF image and set format to JPEG (PSE).

Image 112: JPEG Options panel (PSE).



68

Image 113: Select Image Size (PSE).

Image 114:  Image Size menu (PSE).

5.	 Once saved, resize the image. Open the JPEG file and under Image, click on Resize > Image Size 
(Image 113).

a.	 Set Resolution to 100 pixels/inch.
b.	 Adjust Pixel Dimensions, setting the longest side to 900 pixels (adjusting width or height will 

automatically change the other value when locked) (Image 114).
c.	 Make sure that the Scale Styles, Constrain Proportions, and Resample boxes are checked.
d.	 Select Bicubic Sharper under the Resample dropdown when reducing image size.
e.	 Click OK and save changes.

WARNING:  After saving TIFF as JPEG, the JPEG file will not automatically open in Photoshop 
Elements. Confirm that you are resizing the JPEG file and not the TIFF file.

6.	 Next: Save your files
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Image 114:  Image Size menu (PSE).

Steps for Adobe Photoshop

1.	 Save TIFF image as a JPEG to create a derivative access copy.
2.	 Open TIFF and under File, click Save a Copy.
3.	 Select JPEG as the format and save the file with the accession number as its file name, e.g. 2001-8-7-

1v1.jpeg (Image 115).

4.	 Click Save and a JPEG Options panel will appear (Image 116).
a.	 Set Quality to a minimum of 9 or High.
b.	 Set Format Options to Baseline (“Standard”).
c.	 Click OK.

Image 115: Save a Copy of the TIFF image and set 
format to JPEG (PS).

Image 116: JPEG Options panel (PS).
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Image 117: Select Image Size (PS). Image 118: Image Size menu (PS).

5.	 Once saved, resize the image. Open the JPEG file and under Image, click on Image Size (Image 117).
a.	 Set Resolution to 100 pixels/inch.
b.	 Adjust image dimensions, setting the longest side to 900 pixels (adjusting width or height will 

automatically change the other value when locked) (Image 118).
c.	 Make sure that the Resample box is checked. Select Bicubic Sharper (reduction) under the 

Resample dropdown when reducing image size.
d.	 Click OK and save changes.

WARNING:  After saving TIFF as JPEG, the JPEG file will not automatically open in Photoshop. Ensure 
you are resizing the JPEG file and not the TIFF file.

6.	 Next: Save your files
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Save your files
Digitization is a timely process that requires an investment in equipment, back ups, and continued monitoring 
to safeguard the preservation files and primary access copies. 

For organizations or larger scale digitization projects, consider investing in Digital Asset Management software 
to effectively store, manage, and access your files.

Where to save the files
Save the photograph files on a reliable computer with ample storage and regular backups. For large digitization 
projects, consider investing in a server that can be automatically backed up. Follow your institution’s file 
management system in saving the photograph files or for private collections, save the files to your computer. 

TIP:  Do not use compression software to save the preservation files and primary access copies.

If possible, save a redundant copy of the files on an external hard drive and cloud-based storage to ensure the 
files will not be lost in case of computer failure, updates, or insecure access. 

TIP:  Follow the LOCKSS principle, lots of copies keeps stuff safe.

Transfer the files to the organization’s permanent folders
1.	 Once the preservation files (TIFFs), primary access copies (derivative TIFFs, as needed), and access 

copies (derivative JPEGs) are created/edited, transfer the TIFF and JPEG files from the work computer 
or My Documents to your organization’s permanent digitization folders or server for long-term 
preservation.

a.	 If it is not possible to transfer the files to permanent folders or a server, use a hard drive. See 
Copy the files to external hard drives.

2.	 Select or create a new folder on the computer or server for all digitized files.

TIP:  Create folders within this parent digitization folder based on the type of digitization file (i.e. 
preservation file, primary access copy, and access copy). Follow your organization’s file management 
system in saving files by collection or type of item.  

3.	 Copy digitized files to appropriate folders.
a.	 Use TeraCopy to copy the files with a checksum.
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Copy the files to external hard drives
1.	 Copy the preservation files, primary access copies, and derivative access copies from the work 

computer to an external hard drive to backup the files.
a.	 Create a folder(s) for the collection/series/files on the hard drive. Label the folder(s) with the 

accession number(s).
b.	 Use TeraCopy to copy the files with a checksum.
c.	 Double check the files on the hard drive a week later to ensure the transfer was successful and 

the files are not corrupted. At the end of the project or when needed, delete the original files 
from the work computer only after the files have been copied to at least two locations.

Offsite backup and remote access
1.	 Optionally, copy the TIFF and JPEG files to a cloud-based storage system.

a.	 Create a folder titled “Digitization [year]”. Create folders within this folder for the collection/
series/file.

b.	 Use accession numbers to label the folders.
c.	 If the files contain personal information (e.g. SIN, banking, medical records, current personal 

contact information, etc.), please consider the risks associated with uploading the files to a cloud-
based storage system and consider an alternative backup.
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Use TeraCopy to copy the files
TeraCopy is used to securely copy files from one location to another, ensuring that the copied files are identical 
to the original. TeraCopy is also used to identify transfer failures that may be caused by power or connection 
interruptions resulting in an incomplete transfer or creation of a corrupted file.

Steps
1.	  Use TeraCopy when moving files from computer to computer; computer to server; and computer to 

external storage. TeraCopy will not work when uploading files to Dropbox or any other online cloud 
storage.

2.	 TeraCopy’s layout appears a little different depending on the software version downloaded and 
installed on the computer.

3.	 Open TeraCopy. Under options or in the “On Finish” drop down menu, select “Keep Panel Open.”
4.	 Open Preferences and select (Image 119):

a.	 Confirm drag and drop.
b.	 Use Teracopy as default copy handler.
c.	 Always test after copy. Use MD5 checksums.
d.	 Check free space.
e.	 Expand panel.

5.	 Open Options tab and select MD5 for the checksum (Image 120).

6.	 Move by copying and pasting:
a.	 Select the folder or files to copy to the server or hard drive. Right click and copy (Ctrl+C).
b.	 Open the folder on the hard drive where the files will be copied to. Right click and paste (Ctrl+V).
c.	 A pop-up window should appear with options to “Copy with TeraCopy” or “Copy with Explorer”. 

Select TeraCopy. 

WARNING:  Use “copy” and not “move” to prevent any loss due to failures.

Image 119: TeraCopy preferences. Image 120: TeraCopy Options, select MD5 for the checksum.
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7.	 Confirm the file was transferred successfully. If the file was not successful, recopy the file (Image 121).
8.	 Save the checksum by selecting “More” > “Save Checksums” > “Target” (target is the new folder the 

files are being saved to). Rename the Teracopy checksum file to the accession number (item or file or 
series level, depending on what file(s) was moved).

Image 121: By selecting Keep Panel Open, TeraCopy will remain open after 
the transfer has been completed. The MD5 checksum hash appears next 
to the file name and if confirmed successfully, the checksum sequence will 
appear identical.
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Appendix A: Equipment list and care
This list provides descriptions of some of the equipment in the NNMCC’s object photography kit. Several 
products can be found on the Strobepro website along with instructional videos on set-up, take-down, and use, 
linked below. Purchase equipment that works best for your space and the items you will photograph.

CARE:  Store equipment in a cool, dry, ventilated place and use protective cases to keep them safe 
from scratches and damage. Take care not to drop, bang, bend, or trip on equipment.

Camera
Nikon Z50 Mirrorless Camera 
A high-quality digital camera will allow for high-quality photographs of your objects and the ability to quickly 
review photographs. The camera should have the ability to shoot RAW images, minimum image dimensions of 
3600 x 5000 pixels, and support for Adobe RGB (1998) for post-photography processing. Confirm the camera’s 
compatibility with the tethering and post-photography processing software you plan to use. 

Learn more: https://www.nikonusa.com/p/z-50/1634/overview

CARE: Remove the battery when not in use and charge it for the next photography session.	
Lens and viewfinder: To remove dust or lint, use a hand-held air blower. To remove fingerprints or 
smudges, apply a small amount of lens cleaner to a soft clean cloth and wipe gently. 		
Monitor: To remove dust or lint, use a hand-held air blower. To remove fingerprints or smudges, use a 
soft clean cloth and wipe gently. Do not apply pressure as this may damage the monitor. 		
Image sensor: Do not touch or wipe the image sensor (the glass plate on the camera underneath the 
lens). To remove dust or lint, use a hand-held air blower.

Nikon Nikkor Z MC 50mm f/2.8 Macro Lens
A macro lens can be used for photography of small objects to extend the maximum focal length of the camera 
and allow for increased magnification. The lens can be switched out with other lenses on the camera. Use the 
same lens for each photograph of a single object for consistency in the perceived size of the object. 

Learn more: https://store.nikon.ca/nikon-products/product/mirrorless-lenses/nikkor-z-mc-50mm-f-2-8.html

CARE: To remove dust or lint from the lens, use a hand-held air blower. To remove fingerprints or 
smudges, apply a small amount of lens cleaner to a soft clean cloth and wipe gently. 

 

https://www.nikonusa.com/p/z-50/1634/overview
https://store.nikon.ca/nikon-products/product/mirrorless-lenses/nikkor-z-mc-50mm-f-2-8.html
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Tripod
SmallRig CT180 Video Tripod
Use a tripod to keep the camera steady and produce clear, focused photographs of the objects. A tripod will 
also free your hands to more easily make adjustments to the other photography equipment as needed. Confirm 
that the tripod mount is compatible with your camera model. Consider the maximum height of the tripod and 
the amount of weight that the tripod can support. The tripod should support 3x the weight of the camera and 
the heaviest lens. The video fluid head allows for flexibility in tilting the camera at an angle, such as for the ¾ 
angle. 

Learn more: https://www.smallrig.com/smallrig-ct180-video-tripod-3760.html 

Leofoto HC-28 Horizontal Panoramic Center Column 
A center column can be attached to a tripod to allow for overhead photography. The column extends out at a 
right angle to the tripod base so that the camera can be mounted above the object. A sandbag or weights are 
needed for the other end of the column to support the weight of the camera. The column can be lowered or 
removed to use the tripod normally for straight on photography.

Learn more: https://leofotousa.com/products/leofoto-hc-28-hc-32-hc-32-kit-carbon-fiber-horizontal-
panoramic-tripod-center-column

Lighting
Godox AD300 Strobe Light with Modelling
The lighting in the photography room should provide adequate light for the object(s) and ideally be at a 
controllable brightness and temperature. Strobe lights can be synced with the camera to fire a flash of light 
when the photograph is taken. The modelling light feature provides continuous light for a preview of what this 
flash lighting will look like in the final photograph. The battery-powered option reduces the need for extra 
cables in the photography room.

Learn more: 
https://strobepro.com/products/godox-ad300-pro-ttl-battery-powered-wireless-strobe

CARE:  Remove the batteries when not in use and charge them for the next photography session.

9’ Air Cushion Light Stand 
The maximum height of the light stands will depend on the available space in your photography room. The air 
cushioning ensures that the stand will collapse slowly when height adjustments are made, rather than slamming 
down.

Learn more: https://strobepro.com/products/9-air-cushion-light-stand

https://www.smallrig.com/smallrig-ct180-video-tripod-3760.html
https://leofotousa.com/products/leofoto-hc-28-hc-32-hc-32-kit-carbon-fiber-horizontal-panoramic-tripod-center-column
https://leofotousa.com/products/leofoto-hc-28-hc-32-hc-32-kit-carbon-fiber-horizontal-panoramic-tripod-center-column
https://strobepro.com/products/godox-ad300-pro-ttl-battery-powered-wireless-strobe
https://strobepro.com/products/9-air-cushion-light-stand
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Godox XPROII-N Radio Trigger Controller  
A flash trigger allows you to sync the lights with the camera’s shutter so that they will flash as the photograph is 
taken. Lighting settings can also be controlled on the trigger. This specific model is designed for Nikon cameras 
but there are also models for Canon and Sony cameras. 

Learn more: https://strobepro.com/collections/radio-triggers-1/products/godox-xproii-n-radio-trigger-
controller-nikon

CARE: Remove the batteries when in storage.

Sekonic Flashmate L308X Light Meter
A light meter is used to measure the aperture that the current lighting is set up for. By inputting the camera’s 
shutter speed and ISO and measuring the flash output of the lights, the meter will determine the ideal aperture 
for the set-up. You can make adjustments to the lighting power, distance, and angle to reach the desired 
aperture for object photography. 

Learn more: https://strobepro.com/products/sekonic-flashmate-l-308x-light-meter

CARE: Wipe the meter with a dry, soft cloth. Remove the batteries when in storage.

OrangeMonkie Foldio3 Original All-In-One Portable Studio Lightbox
A lightbox can be used for small objects, without the need to set up a backdrop or external lighting as the 
lightbox acts as a self-contained photography studio. The lightbox comes with its own white backdrop and 
internal lighting. The small object is placed inside the lightbox and photographs can be taken using the tripod. 

Learn more: https://orangemonkie.com/products/foldio3 

CARE: Wipe with a dry, clean cloth. Turn off the power and unplug the power cable and adapter when 
not in use. Do not leave the lights powered on for longer than 3 hours at a time.

https://strobepro.com/collections/radio-triggers-1/products/godox-xproii-n-radio-trigger-controller-nikon
https://strobepro.com/collections/radio-triggers-1/products/godox-xproii-n-radio-trigger-controller-nikon
https://strobepro.com/products/sekonic-flashmate-l-308x-light-meter
https://orangemonkie.com/products/foldio3
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Reflectors and diffusers
40” White Translucent 2 in 1 Umbrella 
Umbrellas can be attached to the light stands to bounce light and create a wider spread of light on the object. 
The covers on the 2 in 1 umbrellas can also be removed to use the umbrella as a shoot-through diffuser to 
soften the light and shadows.

Learn more: https://strobepro.com/products/40-white-translucent-2-in-1-umbrella-1 

CARE:  Wipe clean with a damp cloth. Allow to air-dry or wipe with a clean dry cloth before using or 
packing away.

32” 5 in 1 Folding Reflector with Handles 
Different colours of reflectors can be used to change the strength or colour of the light that is cast on the 
object. Most common for object photography are white reflectors used to reduce shadows and translucent 
panels used to diffuse light.

Learn more: https://strobepro.com/collections/5-in-1-reflectors/products/32-5-in-1-folding-reflector-with-
handles

CARE: Wipe clean with a damp cloth. Allow to air-dry or wipe with a clean dry cloth before using or 
packing away.

Backdrop
Westcott 9x10’ Gray and/or White Wrinkle-Resistant Backdrop  
A neutral gray or white backdrop will ensure a clean, consistent background for your photographs. The neutral 
gray backdrop allows for more visible contrast and depth when photographing 3D objects. Fabric backdrops 
offer more durability but paper backdrops can also be used, as long as the material is matte so there are no 
reflections from the lights.

Learn more: https://www.henrys.com/westcott-9x10-gray-wrinkle-res-backdrop/5637230376.p?color=Grey&si
ze=9%27X10%27&style=New

CARE:  Machine wash with a non-scented detergent and no softener. Tumble dry on low. To reduce 
wrinkles, use a handheld steamer on a low heat setting. Test a small corner first to ensure the heat 
does not cause damage. Consider steaming the backdrop the day before to ensure it is completely dry 
before use. 

https://strobepro.com/products/40-white-translucent-2-in-1-umbrella-1
https://strobepro.com/collections/5-in-1-reflectors/products/32-5-in-1-folding-reflector-with-handles
https://strobepro.com/collections/5-in-1-reflectors/products/32-5-in-1-folding-reflector-with-handles
https://www.henrys.com/westcott-9x10-gray-wrinkle-res-backdrop/5637230376.p?color=Grey&size=9%27X10%27&style=New
https://www.henrys.com/westcott-9x10-gray-wrinkle-res-backdrop/5637230376.p?color=Grey&size=9%27X10%27&style=New
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Duramex (TM) Photography 10' Wide x 7' High Backdrop Stand
An adjustable backdrop stand is helpful to mount and rotate between the different backdrops. The feet of the 
stand are adjustable from 32”-36” diameter and four sections make up the top cross bar, each 2.5’ long. This 
stand is made of lightweight aluminium so always use weighted sandbags for stability support. Easy to connect 
and no tool needed.

CARE: Wipe clean with a damp cloth. Take care when assembling/disassembling to avoid damaging 
the attachment pins or bending the aluminium bars.

Colour target
Datacolor Spyder Checkr Photo  
A colour target is used in object photography to ensure accurate representation of the colour of the object. The 
neutral gray square on the target, also known as 18% gray, has a known RGB value of 120 +/- 5 in the Adobe 
RGB (1998) colour space. These values will be used during post-photography editing to edit the exposure and 
colour balance of the photograph. Some colour targets offer software that you can use to create presets for 
editing but use of the software is not necessary.

Learn more: https://www.henrys.com/datacolor-spyder-checkr-photo/5637433327.p?style=New

CARE: Avoid touching the swatches on the colour target as the oils from your hands will discolour the 
swatches over time and they will not represent the accurate colours. Keep the target clean and out of 
the light when not in use.

https://www.henrys.com/datacolor-spyder-checkr-photo/5637433327.p?style=New
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Appendix B: Project documentation

Use a spreadsheet, form, or database to document your photography and post-photography activities for each 
object, such as photograph views, focal length, lighting, and editing progress. This will be particularly helpful 
if an object photography project is completed over a long period of time and/or by several different staff 
members or volunteers. You may need to refer to the documentation if further photography of the object is 
needed at a later date. 

Changes to lighting between photograph views of the same object should be noted for post-photography 
processing. Camera angle and position, white balance settings, and lighting power and position will all impact 
the final lighting of the photograph. If changes to lighting are present between photograph views, colour 
correction edits cannot be copied from one photograph to another.

An example spreadsheet is provided on the next page.

Documentation fields
These fields may be useful to track in a spreadsheet, form, or database for long-term object photography 
projects or post-photography processing.

Object # and title: The unique identifier and title of each object for identification and naming of files.
Condition notes: Any condition issues that the photography team should be aware of when handling the 
object.
Name of photographer(s): The name of the person(s) who took the photographs.
Date of photography: Date(s) that photography occurred.
# and types of photograph views: The number and types of photograph views (e.g. front, bottom, detail views) 
for each object. This will be compared to the final files for renaming.
Camera angle: The camera angle for each view: straight on, ¾, overhead, or close-up. 
Aperture: The aperture used for each view. This should be consistent for all views. 
Focal length: The focal length used for each view. This should be consistent for all views, excluding detail views 
which may be higher.
White balance: The white balance setting for each view: custom, auto, or a specific colour temperature. Note 
if different custom settings were used for the same object, as this will impact lighting and post-photography 
processing.
Notes on lighting or tripod: Any changes in the power of the lighting, position of the lighting or tripod for each 
view. This field is most important for post-photography processing.
Post-photography editing completed: Note the progress of edits to primary access copies.
Files saved to computer or server: Note the progress of saving all preservation files, primary access copies, 
and derivative access copies to your long-term storage destination.
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Appendix C: Detailed camera settings

1.	 Image quality: NEF (RAW) (Images 122 to 124)
a.	 Click the MENU button and use the arrows or touchscreen to scroll to Photo Shooting Menu > 

Image Quality. Click OK to the desired format of photographs and click MENU to return to the 
display screen. 

TIP:  You can also click the info “i” button on the camera or touchscreen and scroll to Image quality. 
Click OK to set the desired format and click “i” button to return to the display screen.

2.	 Bit depth: 14-bit (Images 122 and 123)
a.	 Click MENU > Photo Shooting Menu > NEF (RAW) recording. Click OK to set the desired bit 

depth and click MENU to return to the display screen.

3.	 Focal length: 
a.	 Set a focal length of 16 for larger objects and 24 for smaller objects.
b.	 Rotate the Zoom Ring (outer ring on lens) to set the focal length. Lens should click into position 

with the line mark pointing at the chosen focal length (Image 125).

Image 122: Menu button, multi-selector 
arrows, and info button on camera.

Image 125: Rotate Zoom Ring to set 
focal length.

Image 123: Photo Shooting Menu with image 
quality and bit depth settings.

Image 124: Info button on touchscreen.
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4.	 Aperture: f8-f11 for 2D objects, variable for 3D objects (Images 126 and 127)
a.	 Click the f-stop value on the monitor and use the right or left arrows to change the value. Once 

the desired aperture is selected, click OK.

TIP:  You can also change the aperture by rotating the sub-command dial.

Image 128: ISO sensitivity settings. Image 129: ISO sensitivity button.

Image 126: Increase or decrease aperture value. Image 127: Sub-command dial (at top) 
and main command dial.

5.	 Shutter speed: Variable (Image 127)
a.	 In Aperture Priority mode, the camera will automatically select an appropriate shutter speed 

based on the selected aperture and focal length, with no manual ability to adjust the setting.
b.	 In Manual mode, click the shutter speed value on the monitor and use the right or left arrows to 

change the value. Once the desired aperture is selected, click OK.
c.	 For handheld photography, use a minimum shutter speed based on multiplying the focal length 

by 2 and dividing the result into 1, e.g. with a focal length of 16, the shutter speed should be at 
least 1/32.

TIP:  You can also change the shutter speed in Manual mode by rotating the main command dial.

6.	 ISO: Auto (Image 127 to 129)
a.	 Click MENU > Photo Shooting Menu > ISO sensitivity settings.

i.	 Set “ISO sensitivity” to 100. This will be the minimum ISO on any image.
ii.	 Set “Auto ISO sensitivity” to On. This setting can also be turned on and off by holding down 

the ISO sensitivity button and rotating the sub-command dial.
iii.	Set “Maximum sensitivity” to 400.

b.	 To manually adjust ISO, hold down the ISO sensitivity button and rotate the main command dial 
to increase or decrease ISO. In Aperture Priority mode, shutter speed will automatically adjust 
with changes to ISO.
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Image 130: Exposure compensation button. Image 131: Exposure indicator on monitor. 
Set as close to 0 as possible.

7.	 Exposure: (Images 127, 130 and 131)
a.	 Hold down the exposure compensation button to show the exposure indicator on the monitor. 

It will appear as a value at the bottom left of the screen and a meter on the left side of the 
screen. The minus-sign of the meter represents underexposure and the plus sign represents 
overexposure. 

b.	 When holding down the exposure compensation button, rotate either the main or sub-command 
dial to adjust exposure. Align the value with 0.0 and the meter bars with 0 or as close as possible. 
In Aperture Priority mode, shutter speed will automatically adjust with changes to exposure.

c.	 In Manual mode, adjusting the shutter speed will also adjust the exposure.

TIP:  Make sure that the image is not overblown (i.e. exposed to too much light and appears too bright 
or white) as this cannot be fixed in post-photography processing. When in doubt, choose the exposure 
that produces a darker image over a brighter image.

8.	 White balance: Create a custom white balance preset or select an existing setting. 
a.	 Once lighting is set up and before placing the object, place the colour target on the table or 

stand where the object will be placed.
b.	 Turn the mode dial on the camera to Programmed Auto (P). Remember to change the mode back 

to Aperture Priority (A) or Manual (M) before taking object photographs.
c.	 Press and hold the Fn1 button on the front of the camera for the White balance menu and scroll 

to PRE using the main command dial (Image 132). 
i.	 If using Auto white balance or a specific colour temperature, scroll to the selection using the 

main command dial. Choose a sub-option by rotating the sub-command dial. The colour 
target will not be needed for these settings and no further action is needed once the setting is 
selected. Change the mode back to A or M.

Image 132: Press and hold Fn1 button and scroll to Preset.
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Image 133: Preset icon in top right 
corner and target square in centre 
of monitor.

Image 135: Shooting/display menu under Custom Setting 
Menu with live view and framing grid display settings.

Image 134: Fill the camera frame with the neutral gray 
square on the colour target and click OK to measure 
white balance.

d.	 With the PRE selection highlighted, press and hold Fn1 until the PRE icon starts flashing in the top 
right corner and the white balance target square appears in the centre of the monitor (Image 133).

e.	 Fill the frame with the neutral gray square on the colour target. The camera should be removed 
from the tripod to get as close to the target as possible. When the frame is filled, click OK to 
measure (Image 134).

f.	 The camera will correct the white balance and store the settings for future photographs taken in 
the same space and lighting conditions. 
i.	 Write over the preset when saving a new custom white balance.

g.	 Press the “i” button to return to the display screen and change the mode back to A or M.

TIP:  White balance can also be accessed through the Photo Shooting Menu or the info “i” menu.

9.	 Live view display: On (Image 135)
a.	 Click MENU > Custom Setting Menu > d Shooting/display > d7 Apply settings to live view. 
b.	 Click OK to turn on and click MENU to return to the display screen.

10.	 Framing grid display: On (Image 135)
a.	 Click MENU > Custom Setting Menu > d Shooting/display > d8 Framing grid display.
b.	 Click OK to turn on and click MENU to return to the display screen.
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Image 136: Monitor mode button.

Image 137: DISP button to change 
monitor display.

Image 138: Adjust angle of monitor screen.

11.	 Monitor mode: Automatic display switch (Image 136)
a.	 Press the monitor mode button to switch between monitor views.
b.	 In Automatic display switch, the display will switch between the monitor and the viewfinder 

when the viewfinder sensor is activated. Other options include the monitor only display or the 
viewfinder only display.

c.	 The monitor mode settings will not be necessary if using tethered software with live view 
support.

12.	 Monitor display:
a.	 Click DISP button on the monitor to change between display options (Image 137). 

i.	 “Indicators on” display will show all of the settings on the monitor. Other displays include a 
simplified view, a histogram display to assist with exposure, and a virtual horizon that provides a 
level for images.

b.	 The angle of the physical screen can also be adjusted for easier viewing, e.g. if photographing an 
object from above (Image 138).
i.	 Pull out the screen from either the top or bottom edge and adjust on its hinge to reach the 

desired position.
c.	 The monitor display settings will not be necessary if using tethered software to display live views 

and settings of the photograph.

TIP:  While browsing settings in the menu, a question mark will appear in the bottom left corner of the 
monitor when some settings are selected. Touch the question mark on the screen for more information 
about the setting.
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Appendix D: Examples
See below for suggestions based on the specific type of object you are photographing. For each view, 
determine whether straight on or overhead camera angles are best suited based on the type and condition of 
the object.

TIP:  Use tables, stands, mounts, foam, and other materials to best support the object being 
photographed.

Butsudan or shrines
For larger shrines, use a table or stand in front of the backdrop. Smaller shrines may be photographed using the 
lightbox.

1.	 Place the butsudan on a table or stand or inside the lightbox depending on the size, along with the 
scale and colour target.

2.	 For shrines with reflective surfaces, see Reflective objects for instructions on reducing glare and 
reflections. To reduce shadows and brighten the interior, see Lighting.

3.	 Suggested views: take photographs of a front view, interior view with the doors open, ¾ view, and 
detail views of any designs as needed. If the shrine does not have doors, the front view can take the 
place of the interior view. If the shrine has different designs on the sides or back, take photographs of 
each side in addition to the front view.

Front, interior, ¾, and detail views of a butsudan. 
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Dolls
Smaller dolls can be photographed using the lightbox while larger dolls can be placed on a table in front of the 
backdrop. If the dolls have multiple components that can safely be taken apart (e.g. a case, stand, or removable 
clothing), take photographs of all components. 

1.	 Place the doll on the table or in the lightbox depending on the size, along with the scale and colour 
target. If the doll cannot stand upright, take photographs using the overhead arm.

2.	 For dolls with glass cases, see Reflective objects for instructions on reducing glare and reflections.
3.	 Suggested views: take photographs of a front view, back view, and detail views of any designs as 

needed. Optional views include a ¾ view and side views of the doll, depending on the desired level 
of detail you wish to capture. If the doll has multiple components, such as a case, stand, or removable 
clothing, also take a photograph of the components taken apart if safe to do so. If markings are 
present on the base of the doll, take a bottom view as well.

Front and back views of a doll.
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Furniture
Ensure that any doors or drawers on the furniture are secured before moving the object so that they do not 
open during transport. Use two or more people to transport heavy furniture. 

Most furniture will be large enough to be placed in front of the backdrop with no table needed. 

1.	 Place the furniture object in front of the backdrop. Use foam as needed to support the base of the 
object.

2.	 Place the scale and colour target on a small table or stand beside the object. Adjust lighting as needed 
to avoid shadows from the table on the object.

3.	 Suggested views: take photographs of a front view, ¾ view, top view, and detail views of any designs as 
needed. If markings are present on the back or base of the object, take a back and/or bottom view as 
well if possible to safely move and support the object.
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Kimono and textiles
Kimono and other textiles should be photographed on a kimono stand or mannequin to accurately represent 
the size and shape of the garment.

1.	 When photographing kimono or textiles, use a mannequin or kimono stand if available.
a.	 If the material is delicate or showing signs of damage (e.g. degrading silk), consider 

photographing it flat instead of on a stand.
2.	 To place the kimono on a kimono stand, remove the top bar and place one sleeve through the bar 

before placing the second sleeve on. 

TIP:  Always have two people to place the kimono on and off the stand for proper care of the kimono. 
Inspect the kimono beforehand for any loose threads that may snag.

3.	 Secure the kimono to the stand with clips on either side of the stand to ensure the full design is visible.
a.	 Tie the clips to the stand using sewing thread and place muslin cloth between the clips and the 

kimono material to prevent the clips from touching the kimono directly. Leave enough slack for 
the clips so the kimono is not pulled too tight. 

4.	 Place the scale and colour target on a small table or stand beside the object. Adjust lighting as needed 
to avoid shadows from the table on the object.

5.	 Suggested views: take photographs of a front view, back view, and detail views of any designs or 
crests. If the interior of the kimono or textile has additional designs or features, also take an interior 
view displaying the design. Take a ¾ view of any textile that is rolled or folded. Overhead photography 
may be suitable for detail views if the item does not hang flat.

Front, back, and detail views of the crest and design of a kimono. Ideally, colour target will be 
placed on a table beside the kimono stand.
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Reflective objects
For objects with reflective surfaces, take special care in setting up photographs to avoid reflections from the 
camera or lighting.

1.	 Some objects like framed photographs and glazed pottery may have very reflective surfaces.
2.	 Adjust the light stands close to the object at 20 to 25 degree angles to avoid reflections of the camera, 

photographer, or items in the room on the object.
3.	 If necessary, remove items from the walls that are reflected in the object.
4.	 Use a white reflector or coroplast boards to soften the light and reduce glare on the object. Hold the 

reflector to the side or in front of the object, outside of the camera frame. Adjust the angle of the 
reflector as needed.

5.	 If available, set up a light tent on the table and place the object inside. Zip up the tent around the 
camera lens to take the photograph.
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Photograph albums and scrapbooks
Photograph albums and scrapbooks can be captured using a flatbed scanner or a digital camera, based on 
the album’s condition or structure. Use object photography for albums that are fragile or have limited opening 
capability.

The original order and layout of a photograph album or scrapbook is important in preserving the historical 
context and intention of the creator. Before removing individual photographs or documents in an album, scan 
or photograph the covers and pages of the album.

Overview of albums
1.	 Types of albums: 

a.	 Black paper albums: the black paper in these albums can become very brittle with age. Be careful 
in handling the albums.

b.	 Sticky/self-adhesive albums: sticky albums have pages with glue that photographs or documents 
are pasted to, with a plastic pull-back cover on top.
i.	 To avoid glare when photographing pages, slowly pull back the plastic cover to avoid damage 

to photographs and documents.
c.	 Mounts: photographs and documents may be inserted in albums in plastic sleeves, glued directly 

to the page, or inserted into photo corners that are glued to the page.

Black paper album. Sticky/self-adhesive album.
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Place foam or a mount under the backdrop to support the weight of the photograph album and the 
angle it will open to.

2.	 Care and handling:
a.	 Wear cotton or disposable gloves when handling albums and photographs.
b.	 If the album is bound with ties that can be safely loosened for ease of photography, photograph 

front and back covers first before untying.
c.	 Where safely possible and if preferred, loosen the binding to allow the page to sit flat. Place foam 

under the front and back covers to support the binding.
d.	 Once all album pages and the front of the photograph(s) have been photographed, gently 

release photograph(s) or document(s) from the page if possible without damage. If there are 
annotations on the verso (back side) of an item, scan or photograph each individually.

TIP:  For sticky albums, you may use a soft unwaxed unminted dental floss to release photographs 
from the page. Slide the floss under a loose corner and gently pull it side to side in a sawing motion. 
Check often to ensure the floss remains underneath the photograph. Do not use this method if there 
are tears in the photograph to avoid any further damage. If photographs are too stuck, do not force 
them and leave them on the page. Keep the photograph flat throughout the process and avoid curling 
the photograph during removal as it will cause permanent damage to the image layer and result in 
cracking.
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Image capture of albums
To preserve the original layout of an album, it is important to capture the front and back covers and pages of 
the album as well as the individual photographs and documents. Scan all pages before removing any items 
from the album.

TIP:  You may skip blank pages in an album if the pages contain no photographs or written text. Make a 
note in the metadata for the object about any blank pages.

1.	 Set up the overhead arm on the tripod. See Overhead photography for instructions.
2.	 Set up the camera at a consistent height and position for photographing all covers and pages.

WARNING:  Remove the object from the photography space before adjusting the overhead arm to 
prevent damage to the object. 

3.	 Place the photograph album on the table with foam to support the covers as needed, along with the 
scale and colour target.

4.	 Photograph the front and back covers. If preferred, loosen any ties as needed to begin photographing 
the pages. 

5.	 Photograph each page of the album from first to last, moving the album as needed rather than the 
camera so that the album page fills the camera frame and the camera position remains consistent. 
Adjust foam supports as needed.

TIP:  If the album does not lie flat, you may need to adjust the angle of the camera to avoid curves in 
the photograph.

6.	 Once all album pages are scanned, gently remove the photograph(s) or document(s) from the album 
if possible, retaining the order of items. Scan each individual photograph and document in order. For 
more instructions, see the Scanning manual.

TIP:  While scanning the photographs is recommended to avoid glare from the glossy paper when 
photographing, some photographs will not be able to be safely removed from the album. If the 
photograph(s) cannot be safely removed, remove the album from the photography space and adjust 
the height of the overhead arm. Lower the camera and adjust the focal length so the photograph fills 
the camera frame. Move the album as needed to centre the photograph in the frame. Photograph each 
individual photograph in order.
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File names for albums
Album pages and individual photographs should have distinctive file names that will easily distinguish them 
from each other, while identifying that they belong to the same album. 

Track the number of pages and photographs in the album you are photographing for ease of later renaming 
when reviewing photographs.

1.	 Rename photograph files in post-photography processing based on the organization’s naming 
conventions.

2.	 For album pages, include an extra prefix in front of the album’s accession number and in front of the 
page number.

a.	 Album pages: album-[album accession #]-pg1, -pg2, etc. ; e.g. album-2018-36-2-20-pg1
3.	 For individual photographs, name the files based on the album’s accession number. If there are 

annotations on the verso of the photograph, include a “b” at the end of the file name.
a.	 Individual photographs: [album accession #]-1, -2, etc. ; e.g. 2018-36-2-20-1b
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Suitcases and trunks
Avoid lifting suitcases and trunks by their handles. Lift the suitcase from its base and support its weight. Ensure 
latches are closed or secured so the suitcase does not open during transport.

1.	 Place the suitcase on the table along with the scale and colour target. Use foam as needed to support 
the weight of the suitcase, particularly the lid when open. If the suitcase cannot stand upright, take 
photographs using the overhead arm.

2.	 Suggested views: take photographs of a front view, top view, ¾ view, and detail views of any designs as 
needed. If the suitcase can safely open, take an interior view using foam supports as needed beneath 
the sides of the suitcase. If markings are present on the back of the suitcase, take a back view as well.

Front, top, ¾, and interior views of a suitcase.
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Swords and knives
Swords and knives should be placed in box lids or trays to transport the objects safely. Line the trays with foam 
and place the objects on top. Be mindful of sharp edges as well as any tears or ties attached to the sword.

Smaller swords or knives can be photographed using the lightbox. If the swords have multiple components that 
can safely be taken apart (e.g. a sheath), take photographs of all components.

1.	 Place the sword on the table or inside the lightbox depending on the size, along with the scale and 
colour target.

2.	 Suggested views: take photographs of side views and detail views of any designs such as a maker’s 
mark. If the sword has a sheath, take a photograph of the sword sheathed in the side view and a 
photograph of all components taken apart if safe to do so. Photograph both sides of both the sword 
and the sheath to help with identifying quality and condition over time.
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Tabi and other footwear
Smaller footwear can be photographed using the lightbox. 

1.	 Place the tabi on the table or inside the lightbox depending on the size, along with the scale and 
colour target. Use foam as needed to support the different view placements of the object.

a.	 Optional: gently pad the inside of the tabi with pieces of batting, fabric, or tissue paper to create 
a 3D shape.

2.	 Suggested views: take photographs of a top view, bottom view showing the soles, ¾ view, and detail 
views of any designs such as a maker’s mark. If the interior of the footwear has additional designs or 
features, also take an interior or detailed view displaying the design. For tabi or footwear that are flat, a 
¾ view is not needed.

Top, bottom, and detail views of a pair of tabi.
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Taiko drums
Use two or more people to transport heavy taiko drums. Be mindful of any loose ties attached to the drum that 
may drag during transport. 

For larger taiko drums, use a stand in front of the backdrop to display the drum. Smaller drums can be 
displayed on a table. 

1.	 Place the taiko drum on a stand or a table depending on the size. If no stand is available, support the 
drum using foam or mounts underneath the backdrop.

2.	 For drums that are photographed without a table, place the scale and colour target on a small table or 
stand beside the object. Adjust lighting as needed to avoid shadows from the table on the object. If 
the drum is placed on a table, the scale and colour target can be placed beside it.

3.	 Suggested views: take photographs of a ¾ view, a front or top view of the playing surface, a back 
or bottom view of the other playing surface, and detail views of any designs as needed. If there are 
designs around the body of the drum, take photographs of each side in addition to the ¾ view.
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Vases
Always support the base of the vase when moving the object. Be mindful of any chips or cracks in the vase. 
Smaller vases can be photographed using the lightbox. 

1.	 Place the vase on the table or inside the lightbox depending on the size, along with the scale and 
colour target. Use foam as needed to support the different view placements of the object. 

2.	 For vases that are very reflective, see Reflective objects for instructions on reducing glare and 
reflections.

3.	 Suggested views: take photographs of a front view, ¾ view, interior view, and detail views of any 
designs as needed. If markings are present on the base of the vase, take a bottom view as well. If the 
design is different around the vase, take photographs of each side in addition to the front view .

TIP:  If the vase is very fragile based on its condition, adjust your views accordingly to prevent further 
damage to the object. 

Front, ¾, interior, bottom and detail views of a vase.
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